Quick Start Guide
Quick Start

This guide will help you learn basic navigation of the Web Performance Load Tester interface as well as the
steps to record, replay and analyze the performance of a your website.

Installation

Getting Help

Updating the Software

Navigating the User Interface
Record a testcase

Inspecting a testcase

Replay a testcase

Analyze the performance changes
Run a Load Test
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Installation

Supported Platforms

Web Performance Load Tester is supported and tested on Windows 2000, Windows XP and Vista. It should
also work on most other modern Windows versions.

note: Installation of the Load Engine is supported on Windows, Linux and Solaris. Installation of the Server Agent is supported on Win-
dows and Linux.

Installation Notes

« ForLinux stand-alone installations, do not install the application at the top level directory (at"/"). There
is a known issue with the install application when this directory is used.

« Forany installation, ensure that the directory the application is being installed in is not a read-only
directory to the users of the application. The application will not start properly when this occurs.

« For stand-alone installations, do not install Web Performance Load Tester and Web Performance
Load Engine in the same directory.

Installation steps

Download the software from http://webperformanceinc.com/download

On Windows, run the installer and follow the wizard

On Linux/Unix with a GUI, run the installer and follow the wizard

On Linux/Unix from a console, run the installer with the "-i console" option.
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Load Engine and Server Agent Installation

Load Engine installation instructions

Server Agentinstallation instructions

Getting Help

Integrated help system

This page is part of the Quick Start Guide within the integrated help system. There are four books in the help
system:

« Quick Start Guide - use this for a demonstration of the most commonly used features
« Tutorials - task-specific guides for accomplishing a specific goal
« FAQs - contains questions frequently asked by users and other topics not addressed by the other

books
« Reference Manual - contains detailed information about various program elements and technical top-

ICS

The integrated help system is accessed from the Help Contents item in the Help menu.
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Help Conkents

Bookmarks

Help topics can be book-marked for quick reference in the future using the Bookmark button at the top of the
help window. Links or tabs at the bottom of the help window displays a list of saved bookmarks.



Getting more help

If you cannot find answers in the online help resources, more help is available through our issue tracking
system.

Reporting issues

You may also report bugs and request enhancements using the integrated support request form. The Sup-
port Request Form is available from the Support Request item on the Help menu.

Filling in the form

Enter your e-mail address, and choose either the Open new request or Attach files to existing request
options. For new requests, please fill in a short summary, description and select a category. Additional infor-
mation related to the request can be sent by selecting the appropriate items (e.g. testcases or loadtest
results).

Updating the software
Updating to the latest patch for your version

Updates to the Web Performance software can be easily obtained via the integrated update system.

1. Open the Install/Update wizard from
the menu: Help -> Software Updates ->

Find and Install...
Feature Updates
Choose the way wou wank to search For features boinstall
L3
2. Select the "Search for updates..." (+ Bearch for updates of the currently instalied Features!
option and the Finish button. Select this option if you want to search For updates of the Features vou already have in

™ Search For new features ko instal

Select this option if vou want ko install new Features From existing or new update sites,
available, You can add new update site URLs ko the search.
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3. Follow the wizard to complete the
installation.

You may be prompted to restart the
application after updating. This is not
always necessary, but is the rec-
ommended action.

For detailed information on downloading patch updates and upgrades, see the Managing software updates
reference page.

Navigating the User Interface
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The Navigator shows the contents of each open repository. Double-click repository items (or select a test-
case and choose Editfrom the pop-up menu) to open itin an editor.

Note: Every open repository loads the contents of each test cases into memory. Closing unused repositories
will reduce the memory consumed by the test cases.



Toolbars
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The toolbars provide shortcuts to the most common operations in the Navigator and Editor.

Editors and Charts

The Testcase Editor displays the recorded testcase as a tree of pages and URLs. The testcase can be
sorted by the size and duration columns to quickly find the slowest pages and URLs in the testcase. An icon
at the beginning of each row differentiates web pages from text files, images, forwards and errors. Secure
transactions (SSL) are indicated by a lock icon at the beginning of the URL column. The editor can also dis-
play the performance differences between two replays of a testcase.

The Dataset Editor displays and edits the data and settings for a Dataset.

The Performance Trend chart shows the changes in page size and duration over multiple replays of a test-
case. ltis opened from either the Navigator pop-up menu or the drop-down menu in the editor.

Detailed inspection views

« Content view renders the content of web pages, images and other resources when they are selected in
the editor.

« Headers view displays the HTTP request and response headers for the page/URL selected in the
editor.

« Errors view lists any errors encountered during the recording or replay of a testcase

« Replay view indicates the status of the replay in progress.

« Fields view displays the HTTP fields that can be associated with modifiers.

» Validators view displays size and content validators applied to a Web Page or Transaction in a Test-
case.

« Servers view displays CPU and memory usage metrics for the specified machines.

Status View

The Status View displays the status of long-running operations, such as recording, replaying testcases and
opening repositories.

General GUI features

Editors vs. Views



Editors (including reports) are always located in the center of the Load Tester window. Views can be
arranged around the edges of the Load Tester window. Once the size of a view has been set, it will try to
maintain that size as the Load Tester window is resized. The editors will receive whatever space is left over.

Resizing
Any of the panes in the Load Tester window can be resized and the new sizes will be remembered when
you restart Load Tester.

Rearranging

Any view can be reordered within the tab group or moved to other place in the window by dragging the tab
for that view. The entire tab group can be moved using the Move->Tab Group menu item from the tab's pop-
up menu.

Detaching floating windows
Any view can be detached to a separate floating window using the Detached menu item from the tab's pop-
up menu. Editors cannot be detached.

Minimizing and Maximizing
Each editor and view can be minimized or maximized within the Load Tester window using the mini-

mize/maximize buttons at the top right corner of each view. The editors and views can also be minimized
and maximized by double-clicking the tab for the editor/view.

Viewing multiple editors
By default all editors appear in the same area of the Load Tester window. To view multiple editors side-by-

side, drag the tab for the editor towards the desired edge. Restore the arrangement by dragging one editor
tab onto another editor.

Create a Recording

To create your first website recording, follow these steps:
1. Press the Record @ button.
2. Follow the wizard steps to auto-detect the network settings and select a browser to use for recording.
3. Enter a name for the testcase, select a repository and a network speed (optional).

4. When the browser is launched, visit your website. As you browse the website, Analyzer will record the
pages and URLs retrieved from the server.

5. Press the Stop® button to end the recording and close the browser.



You may now review and inspect the contents of the recording in the Editor. The other views (Headers, Con-
tent, Errors, etc.) will updated to show additional information about the pages and URLs you select in the
recording.

Notes:

The configuration wizard can be reopened at any time using the Recording Configuration Wizard menu item
on the Recording menu.

Inspecting a Testcase

A recorded testcase is represented in the Testcase Editor by a tree of web pages and URLs. Expanding the
web pages reveals the URLs that make up the web page.
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When a web page or URL is selected in the Testcase Editor, some views display details about the selected
item. Web pages are displayed in an embedded browser in the Content View. Images and other text




resources are displayed in text and image viewers, while other resources are displayed in the raw viewer.
The Headers View displays the HTTP headers while the Errors View lists any errors encountered during the
recording.

Tutorials Index

Video Tutorials

(see list on website)

Online Tutorials

Full tutorials:
« Measuring SugarCRM Performance
o Load Testing an AJAX Application
o Load Testing 101: ASP .Net Applications

Mini tutorials:
« Best Practices
o Unique User Logins
o Customizing User Input
o Creating a Dataset
« Overriding ASM
« Handling AJAX callbacks
« Load Testing from the cloud

Load Testing Tutorial

Part 1: Record and Analyze a Testcase
Part 2: Configure and Replay a Testcase
Part 3: Run and Analyze a Load Test

Web Services

Testing a Web Service presents a step-by-step example of testing a simple web service.

Advanced Configuration

The Advanced Configuration Guide demonstrates several techniques and product features for configuring
testcases for web applications that use complicated session-tracking techniques or dynamic field naming
conventions.
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Replay a Testcase

Replaying a testcase creates a virtual user which simulates a real person using a browser to interact with a

website following the same steps as the original recording.

To replay the testcase, open the testcase in the Editor and press the Play ¥ button. A wizard appears,
requesting information required to configure the testcase for replay. For simple testcases that do not require
a user to log in to view content, using the same user as recording and allowing the application to auto-
matically configure Session Tracking and Application State Management should allow the replay to run suc-
cessfully. Once "Finish" is selected on the wizard, the editor clears the pages and URLs replayed appear in
the editor (similar to the recording process) as the replay proceeds. The replay is added to the Replay selec-

tion list, at the top of the editor.

The Replay View appears, displaying the current status of the replay.
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Analyze the Performance Changes

As soon a replay has been initiated, it appears in the replay selection list, as shown below. The testcase
editor reflects the performance measurements of the selected replay for the testcase.
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To easily see the performance differences between two replays (or a replay and the original recording),
select the Compare fo... menu item in the Testcase Editor menu. The testcase editor adds new columns that
show the changes in the size and duration of each page and URL in the testcase.
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To display the changes in performance of web pages over more than two replays, open the Testcase Report
. For example, selecting the Open Report item from the Testcase Editor menu. Then navigate to the Trend
section of the report.
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Run a Load Test

The first step is to create a Load Configuration. Select the testcase in the Navigator and, from the pop-up

menu, choose New Load Configuration:
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Fill in the Load Configuration options as desired:

Record Mew Teskcase, ..
Mew Load Configuration

Load Configuration [1] 22
Test Duration
@ Run for 4 minutes -
) Run maximum repeats

Data Collection

Sample period 10 -

Detailed Page Durations

More...
Individual URL Metrics -

Select testcase to add... ~ | % =

Testcase

recording [4]

Virtual Users
Start with 50
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100 maximum users
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S .
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- .
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VU Start Delay
Random 1

Repeats

n/a

Once the configuration is acceptable, press the Start (ﬁ) button. The Load Test overview screen will appear

while the load test runs:
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When the testis complete, press the Report... button to open the Load Test Report:
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You may also use the Errors View and Metrics View to get more detailed results of the load test.




Videos

Please see the complete list of videos on our web site.



http://www.webperformanceinc.com/load_testing/demo/
http://www.webperformanceinc.com/load_testing/demo/
http://www.webperformanceinc.com/load_testing/demo/
http://www.webperformanceinc.com/load_testing/demo/
http://www.webperformanceinc.com/load_testing/demo/
http://www.webperformanceinc.com/load_testing/demo/
http://www.webperformanceinc.com/load_testing/demo/
http://www.webperformanceinc.com/load_testing/demo/

Tutorials Index

Video Tutorials

(see list on website)

Online Tutorials

Full tutorials:
« Measuring SugarCRM Performance
o Load Testing an AJAX Application
o Load Testing 101: ASP .Net Applications

Mini tutorials:
« Best Practices
o Unique User Logins
o Customizing User Input
« Creating a Dataset
o Overriding ASM

Handling AJAX callbacks
Load Testing from the cloud

Load Testing Tutorial

Part 1: Record and Analyze a Testcase
Part 2: Configure and Replay a Testcase
Part 3: Run and Analyze a Load Test

Web Services

Testing a Web Service presents a step-by-step example of testing a simple web service.

Advanced Configuration

The Advanced Configuration Guide demonstrates several techniques and product features for configuring
testcases for web applications that use complicated session-tracking techniques or dynamic field naming
conventions.

Introduction to Load Testing

Introduction To Load Testing

Web site load testing refers to subjecting a web server to a ramping number of simulated users. The result-
ing analysis can measure your server’s existing capacity, and is an integral part of improving the
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performance of any web-based application.

The purpose of the tutorials is to describe the Web Performance, Inc. load testing methodology so that our
customers will understand how to systematically test their websites using our software, but it is also appli-
cable to other performance testing situations. The questions that are typically answered with load testing
include:

o How Many Users Can Your Web Site Handle?
« Which Web Pages Are Slow?

« Does My Site Crash Under Load?

« How Many Hits/Sec Can My Web Site Serve?
« What's My Site's Bandwidth Requirements?
What's My Site's Baseline Performance?

There are three phases to the testing, which roughly correspond to:

1. Baseline Analysis
2. Test Development/Verification
3. Full Scale Performance Testing

Each phase of the testing process has its own prerequisites and deliverables. The Web Performance Load
Tester™ is designed to facilitate this testing process by separating the different parts of performance testing
into different tasks, and by automatically generating the reports needed to both analyze the performance and
communicate that information to others.

Virtual Users

The virtual users emulate a browser in every way; the web server can not tell the difference between a real
user hitting the web site and a software-generated virtual user. Your web pages are grouped into trans-
actions called test cases so you can get measurements that have meaning for your business. The illustration
below shows how each virtual user can execute a totally different business case, creating a realistic load on
your web site.
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Another term to know is "user identity" which describes a particular user with their own username, pass-
word, etc. A test case could have millions of user identities, but only have one hundred of these active at any
given time. The software license describes the number of simultaneous virtual users, which are different
from how many user identities exist. From a technical point of view, when you have, for example 100 active
virtual users, itis really describing the level of concurrency; 100 users are active at one time. The user iden-
tities, though, will be swapped out as needed to maintain 100 concurrent test cases. From the point of view
of a virtual user, when a test case finishes, it repeats that test case using a new user identity.

How many simultaneous virtual users you need to simulate depends on a number of factors, starting with
how you express your web site's capabilities. Please refer to the hardware requirements for more infor-
mation.

One thing to keep in mind that performance testing starts with testing your individual back-end machines.
Most large web sites scale by adding web servers and application servers. Setting up a large multiple server
performance test takes significantly more time and resources than setting up a single server test. For that
reason, you may want to start testing with a small number of virtual users on an individual test server.

For detailed background information about doing performance tests on a web server check out our mini.
book reviews, or call for more information.

business
case 3 repeated

business
case 3

Recommended Reading

While Web Performance Load TesterTM makes it as easy as possible to do web performance testing, test-
ing and tuning involve a lot more than simply using a tool. For detailed background information about plan-
ning, documenting, and tuning as well as performing tests we recommend the following books:
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Professional Web Site Optimization by Scott Ware, Michael Tracy, Louis Slo-
thouber, Robert Barker

Although this book was published in 1998 it still holds up as the best introduction
to web performance tuning. It covers a wide range of topics, and covers every-
thing you need to know to get started load testing. The age of the book means it
doesn't cover some new topics, but surprisingly enough most of the book is still
relevant. If you are new to load testing and don't know where to start you should
purchase this book first.

Web Performance Tuning by Patrick Killelea

Published in 1998, this book is one of the best for web performance testing, cov-
ering the technical basics for everything you need to know in order to really
understand performance tuning. It includes such required information as def-
initions of various performance metrics, and what those should be in the real
world, and moves along through networks, hardware, and operating systems. It
goes to great pains to cover a variety of systems, including Windows, Linux, Mac-
intosh, and a variety of web servers.

ColdFusion MX: The Complete Reference by Jeffry Houser

Although this book is specifically about ColdFusion, it does have a chapter on
performance, and gives details how to both monitor and test the performance of a
ColdFusion server. The basics of performance testing with Web Performance
Load Tester are presented in context, showing how and why it should be used in
a professional setting. We've gotten good customer feedback on this book.

The Web Testing Handbook by Steven Splaine and Stefan P. Jaskiel

This book is about web testing in general, not just performance testing, and is a
must have for the professional testing engineer. Chapters 7 and 8, on per-
formance and scalability give a very good introduction to the subject, and include
a great sample performance testing plan.

Testing Applications on the Web

Test Planning for Internet-Based Systems by Hung Q. Nquyen

As its title would suggest, this book is all about test planning for all types of inter-
net based systems. Its chapters on performance testing give a lot of details about
planning a performance test and analyzing the results, including examples. If you
really are interested in doing a complete and thorough performance test, this
book is required reading.
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Capacity Planning for Web Performance : Metrics, Models, and Methods by Dan-
iel A Menasce, Virgilio A. F. Almeida

This book is a collection of technical articles on the theory of performance test-
ing, and a good addition to the library of someone interested in the scientific and
engineering aspects of web performance.

LAN vs. WAN

Load tests can either generate load from the same LAN as the web server, or from outside the LAN. The
inside-the-LAN approach removes the service provider's network performance from the equation, but
requires resources at the same location as the web server. This is the most cost effective way to load test

since all of the network traffic is contained, and thus does not incur bandwidth charges from the web hosting
provider.
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LAN-based Load Generation

When users are simulated from outside LAN, the network latency and network performance of the service
provider are measured, but that also can make it more difficult to distinguish between network-related per-
formance problems and server performance problems. This is also the most expensive way to test since the

excessive bandwidth used during a load test has the potential to incur large extra fees from the hosting pro-
vider.
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We strongly recommend a tiered approach to load testing regarding bandwidth:

1. Firstan initial bandwidth usage analysis in Phase 1 gives a rough idea of the bandwidth and network
requirements.

2. Next, LAN testing is used to isolate and verify the correct operation of the web server. Once itis ver-
ified that the server, database, etc., can handle the load, then the measured bandwidth metrics can be
taken to the web hosting company and used for capacity planning.

3. Finally, if there’s any question of bandwidth capacity being a question an external WAN-based test
can be accomplished, with the understanding that this will potentially incur bandwidth charges from
the hosting company, and will increase the overall cost of the test.



Load Testing Process

Phase One - Baseline Analysis
Phase One Testing Procedure
Baseline Analysis

The preliminary analysis consists of recording one or more representative test cases to better understand
the application and scope of the testing. The end goal is to get a picture of the “baseline” performance,
which is the fastest the performance can be under any circumstances. Because recording is easy to do, the
costs of performing this analysis are comparatively low.

Prerequisites:

The following items must be provided in order to complete Phase 1:

Asdefinition of acceptable performance

Asdescription of at least one representative test case

Access to the web-application with non-critical data

Access to someone who understands how the application works.

Performance Criteria

There’s no pointin doing a performance test if you don’t know what to do with the results. Its best to decide
on performance goals for your website right at the beginning before going through the time and expense of a
test. There are no easy answers to this question, since the goals vary by application. Studies show that the
percentage of people who give up on a website and go somewhere else go up as the performance
decreases, but there’s no industry standard for where to draw the line. The performance goals can be
expressed as:

X percentage of web pages should load in N seconds,
with no more than Y percent errors.

If you're still stumped you can start with a goal of having web pages load in between two and four seconds
for normal operation, although you might try staring out your watch for seconds to see how truly long a
period that can be when you’re waiting for a web page. Of course, it's possible for most pages on a site to
load quickly, while a couple of pages require longer periods of time, which is why there’s a percentage qual-
ifier. A good place to start for error percentages would be 1%. Our own published research shows that web
servers will start rejecting connections while performance is still in the acceptable range, and that’s part of
normal operation.



Execution:

During the execution of Phase One, one or more test cases will be recorded in the browser and then
analyzed. These steps are explained in the subsequent chapters Record A Testcase and Analyze A

Recording.

Deliverables:

The Web Performance Analyzer™ module of the Web Performance Load Tester™ will generate the fol-
lowing information in a report which you can both edit and print.

Base Performance Analysis

The base performance is the fastest the system will perform under any circumstances. Before starting a per-
formance test it makes sense to first investigate whether the system meets performance requirements while
not under load. This report highlights which web pages do not meet your performance goals at various band-
widths.

Bandwidth Requirements Analysis

Using the base performance it is possible to estimate the bandwidth required to simulate any number of
users, and is used as a ball-park figure to see if the available bandwidth is adequate before starting a load
test.

Record A Testcase

Recording

Recording is the process of interacting with a website while Analyzer listens, records and analyzes the
HTTP transactions between the browser and server. Analyzer constructs a tree representing the pages and
URLs visited during the session. The recording may be inspected and replayed at a later time.

For a walk-through of the basic process, see the Create a Recording section of the Quick Start Guide. A
recording can be initiated from the Record (@) button and stopped with the Stop (®) button from the toolbar:

@ B B ke (] B R

Once arecording is started, a new Editor tab is created to display the recording.

Browser and proxy configuration

In order to record the HTTP transactions, Analyzer acts as a HT TP proxy for your browser. This requires a
change the the browser's proxy settings for the duration of the recording. The first time a recording is per-
formed, the Recording Configuration Wizard will determine the correct proxy settings and prompt for the



preferred browser for recording. To repeat this process, wizard can be restarted using the Recording->Recor-
ding Configuration Wizard menu item.

The preferred Browser and Proxy settings may be configured automatically in the Preferences editor. For
details on configuration settings, see the Browser Settings and Proxy Settings pages.

Status display

While recording, the Status View will display the vital details about the recording status:

CE N = =5
Record
1 Pages 00:02.10
13 URLs 32 kbytes
7 Conn, (4 open) 0 Errors
[Seomg]

Recording SSL

How it works

When browsing SSL sites your browser encrypts the information sent to the server where it is decrypted. Nor-
mally, if a proxy is used by the browser, the proxy does not encrypt/decrypt the transactions - it simply

passes the encrypted information through. In order for Analyzer to record the transactions, the internal record-
ing proxy works differently - it decrypts/encrypts the transactions.

To make this work, Analyzer generates a "fake" certificate and presents it to the browser as the certificate for
the server. In normal situations, this is considered a security hazard -- so when the browser detects this sit-
uation, it will display a warning message stating that it cannot verify the identity of the server. This is a good
thing! If it didn't, then other programs might do what Analyzer does in order to steal your personal infor-
mation.

To proceed with recording, you can simply accept the certificate and continue with the recording. This will
not adversely affect Analyzer's ability to record your session, but it might produce recordings with response
times that are significantly longer than a normal user would see (because of the time it takes you to dismiss
the warning dialog). If a site uses multiple servers (such as most large banking and e-commerce sites), the
security warning may be displayed multiple times.

How to suppress the warning messages

Analyzer generates an internal root certificate that is used to sign all of the "fake" server certificates. This
root certificate may be imported into your browser as a "trusted root certificate authority”. This will allow your
browser to automatically accept the certificates that are presented by Analyzer without displaying a warning



message. Note that the internally generated root certificate is unique to your computer - this ensures that the
certificate could not be used in a server-spoofing security breach (unless the attacker had already gained
access to your computer and stolen the certificate).

To suppress the warning messages, two steps are required:
1. Export the root certificate
2. Import the root certificate into your browser

Exporting the root certificate

The root certificate may be exported in two different formats: CER or PEM. Most browsers will accept the
CER format, so try it first.

Start a recording
When the Welcome Page appears, click the test your SSL configuration link

Click the appropriate link to download the certificate in either CER or PEM format

Save the certificate somewhere you can remember (e.g. your desktop)

Follow the instructions for your browser on importing the certificate. We have included instructions for
a few of the most popular browsers below. If your browser is not listed here, check the documentation
for your browser.

abhwn =

note: the CER and PEM certificate files may be copied directly from the following folder (where <user> is your windows username) if
the download links do not work:
C:\Documents and Settings\<user>\.webperformance

Internet Explorer 6.0

Select Tools->Internet Options from the IE menu

Select the Content tab

Push the Certificates button

Select the Trusted Root Certificate Authorities tab

Push the Import... button to start the Certificate Import wizard

Push the Next button

Push the Browse... button and locate the certificate file where you saved it
Then follow the Wizard to completion

ONOGORWN =

After installing the certificate, you will see it listed under the name Web Performance. The certificate will
expire in 10 years.

Firefox 1.5

Select Tools->Options from the Firefox menu
Select the Advanced icon

Select the Security tab

Push the View Cetrtificates button

Select the Authorities tab

aobhwbd=



6. Push the Import button and locate the certificate file where you saved it
7. Select the "Trust this CA to identify web sites” option
8. Push the OK button

After installing the certificate, you will see it listed under the name Web Performance. The certificate will
expire in 10 years.

Bandwidth Simulation

During recording or replays, Analyzer can simulate bandwidth-limited networks to demonstrate the effect of
slower connections.

note: the simulation only limits the incoming responses from the server (i.e. requested pages, images, down-
loads, etc.).

Recording

Before beginning a recording, the simulated bandwidth can be selected from the list. To turn off bandwidth
simulation, choose the unlimited option, which will deactivate the internal limiters.

x|
Start a recording

@ Please provide the Following infFarmation before you beqgin recording,

Testcase name: | recording [1]
“hoaose repositary: IC:'I,P'rl:lgram Files\wPanalyzeriworkspace\MyRecordings wpt LI
Bandwidth limit: ISE- Kbps (Maodem) ;I

™ Do not show this dialog unless necessary R

Replay

To replay a testcase using bandwidth simulation, open the Replay view and select the bandwidth from the
list. The simulated bandwidth may be changed at any time during the replay.



-~

=
Conkent | Headers Errnrsm

= e E
Testcase: 11:49 4M 1216/05 replaw Duration: 00:03,56

Skakus: playing Errars: 0

Pages; 3af &

URLs: 17 of 20
Current Page: ‘“Website Load Testing Sofftware - Web Performance, Inc. [2] - http:ffwebper IUnIimited

+ | hiost

I skate | txnleast LRL
1! | webperformanceinc, com: S0 waiting

1 26 http:/fwebperformanceinc. comfimages/download_anl. gif
0 webperfarmanceine, com: 30 receiving 33 http:f fwebperfarmanceine, com)imagesd)analyzer_sm.ipe
z counter?, hikslink, com:ao idle 3 htkp:ffcounterz . hitslink, com)'statistics, aspiv=18s=207

=

4| | i
Connections | Datasets |

After replaying with bandwidth limiting activated, the timing shown in the testcase editor will reflect the
effects of the simulated bandwidth limitations. The effects can also be viewed on the Performance Trend
chart, which might look something like this, depending on which network limits have been tested.
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- Web Server Load Testing Tools - Web Performance Center [1] - Weh Server Load Testing Tools - Weh Performance Center [2]
Weh Server Load Testing Tools - Web Performance Center [3] Load Testing Tools - Web Performance Center
Web Server Load Testing Tools - Web Performance Center [4]

Page | coriginal | 1ombit| 1 mbit| Sizkbps | t2akbps | Sekbps |
weh Server Load Testin... 0,601 0.731 0,971 1,572 4,457 11.307
[#]web Server Load Testin... 1.112 1,101 1,432 2,164 5,443 13.97
Web Server Load Testin... 1,402 0.932 1.062 1,352 2,874 £.64
[ Load Testing Tools - We. .. 0,541 0.831 1,402 2,563 7.821  21.481
weh Server Load Testin... 0.35 0.661 0.57 0.962 1,692 4,306

Analyze A Recording

Performance Goals

Performance can be judged by setting Performance Goals that are automatically evaluated by Analyzer to
give a quick visual assessment of the performance of a website.

Evaluating Performance Goals

When a testcase is displayed in the Editor, the applicable performance goals will be evaluated for each
page and URL. ltems that do not meet the performance goals are indicated with an & icon. Hovering the



cursor over the icon will display a tooltip summarizing the failed goals.

Setting Performance Goals

For instructions on configuring Performance Goals, see the Performance Goals settings page.

Baseline Analysis

Once a testcase is recorded then baseline analysis can be performed by creating a Load Configuration.
The purpose of the configuration is to specify the basic parameters of the load which will be used to gen-
erate the analysis, i.e. number of users, bandwidth of the users, etc.

To start a Baseline Analysis right-click on the test case and select New Load Configuration.
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A new Load Configuration window will appear as shown below. This can be configured using the infor-
mation in the Load Test Configuration Editor section of the Reference Manual.
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Once this has been configured to describe a load test, then the baseline analysis can be viewed by right-
clicking on the Load Test Configuration in the Navigator:
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ﬁ Fun Load Test

of Cut

Al

The following Baseline Performance Analysis report will appear:




SUMIMarY | Eandwidth | Goals | Masker Launch | Settings

Y

Baseline Performance Analysis: Load
Configuration [2]

Analysis Summary

Bandwidth requirements for 750 users

Minimum Bandwidth Required 14,1658.1 kbps
{estimated)’

Total User Metwork Speed 38,340.0 kbps

The Summary gives an overall summary of the report's findings, the Bandwidth report gives estimated
values for the minimum and maximum bandwidth connection needed by the hosting company to support the
specified number of users, and the goals shows how many of the web pages will be estimated to meet or fail
the performance goals. Of course these are just estimates and an actual load test will need to be run to get
definitive answers.

Phase Two - Test Configuration
Phase Two Testing Procedure
Customize & Verify Test Cases

The goal of Phase Two is to make sure that simulation will be accurate, and that all aspects of the

test meet the requirements, including network availability. This phase takes the most amount of time
because it is here that the details of how the back-end works must be worked out. While Phase One relied
strictly on recordings for analysis, in Phase Two the Web Performance Analyzer™ module will simulate a
user with accurate data substitution, which puts extra requirements on the testing process. To make sure
the virtual users are accurate the tester can actually watch the pages as they are sent to the web server, and
visually confirm that everything is working correctly.

Prerequisites:

« A small number of accounts, usually between 10 and 20.
« A representative of the application/operations team to monitor the correct operation of the tests
« Test cases must be configured for multiple logins and unique data.



Execution:

« Record remaining test cases

« Configure test cases for unique data such as separate logins

« Check application state if used

« Configure validation (if needed) so you know the test cases are working

« Replay each test case with a single user to verify they are working correctly

« Repeat each test with more than one user to make sure multiple, simultaneous authentications
are working

Deliverables:

« A suite of tests ready for a larger-scale multi-user simulation
« The final list of requirements for Phase 3.

Configure and Replay a Testcase

Configuration

Authentication

Authentication is the process by which the user tells the server who he/she is. The user may provide this
information in a number of different ways and the server may or may not accept the credentials. After the
server has accepted the user, the rest of the web application is made available. There are 3 common mech-
anisms of authentication in web applications, as described below.

In all cases, we recommend using different credentials for each virtual user during a load test to accurately
simulate the behaviour of real-world users. We have a tutorial which illustrates a common use-case.

Web-form login

In this method, the username and password are entered on a web page and submitted by the browser. This
may be done over either secure or insecure connections. When replaying the testcase, the default behavior
will be to submit the same username and password as was used during the recording. This can be cus-
tomized by using the User Identity wizard or by locating and editing the fields in the Fields View.

HTTP authentication

This method uses the HTTP WWW-Authenticate and Authorization headers as described in the HTTP spec-
ification to send the credentials to the server. The browser is responsible for prompting the user for cre-
dentials. In the case of Internet Explorer, it may use the current users credentials transparently and only
prompt the user if these credentials are rejected.

This method includes a variety of protocols that determine how the credentials will be transmitted from the
browser to the server. Common protocols are Basic and Digest (RFC-2617), NTLM and Kerberos. The
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Negotiate method (RFC 4559) allows the client and server to negotiate which protocol to use based on their
capabilities. Negotiate is most commonly used by Microsoft servers and usually results in the selection of
NTLM or Kerberos. Authentication with a proxy server is also supported in this method, though the headers
are different: Proxy-Authenticate and Proxy-Authorization.

Load Tester currently supports Basic, NTLM and NTLM via Negotiate.

Integrated Windows Authentication is performed by IIS servers usually using NTLM or NTLM via Negotiate,
and subsequently is supported by Load Tester for these security methods.

The user identity that will be provided for Basic and NTLM authentication can be customized by using the
User Identity wizard or in the User Identity tab of the testcase properties dialog (select Properties from the
pop-up menu on the testcase in the Navigator view).

Client Certificates

This method uses encrypted certificates installed in the browser to identify a user over a secure (SSL)
connection. Load Tester must be configured to use client certificates before the testcase can be recorded or
replayed.

Application State Management

Modern web-based applications are getting more and more complex, which makes testing those appli-
cations very difficult. The web server or client-side javascript can generate unique hidden variables or sep-
arate URL paths for each user. Sessions can be specified not just through cookies, but hidden in the web
page itself. Values from previous forms can be compressed, encoded, and stored inside variables with
names like " VIEWSTATE". Sometimes even the names of form variables changes from one user to
another. Note that Application State Management does not deal with data that the user would enter in
form fields or any other type of user-entered data. Application State Management is about all of the other
complex variables changing behind the scenes. To change the input entered by the user in a form, see the
section on Customizing a Testcase.

With a scripting-based load tester you'd have to find each dynamic variable and where it is used, and con-
figure it by hand, if it is supported at all. A typical application could have hundreds of dynamic variables,
which means developing the test case can take days even if you understand the scripting language. Load
Tester's Application State Management wizard automatically finds and configures each dynamic variable for
you. It locates where the variable is first used, and configures a parser to extract that value at runtime, and
then detects where the value is used, and configures data replacement so that each virtual user gets its own
unique runtime value.



http://tools.ietf.org/html/rfc4559
http://tools.ietf.org/html/rfc4559
../../../AnalyzerHelp/Content/Customizing_a_Testcase.htm
../../../AnalyzerHelp/Content/Customizing_a_Testcase.htm
../../../AnalyzerHelp/Content/Customizing_a_Testcase.htm

Starting the Application State Manager

The Application State will normally be automatically configured by the Testcase Configuration wizard before
a replay can be attempted. To run the wizard again at a later time, select the testcase in the Navigator (or

open the testcase in the Testcase Editor) and select the Configure — Application State option from the pop-
up menu or toolbar.

T R,

Application S5tate Management

Configure Dynamic Fields in test case Value increment loop

The Application State Managem ent wizard will configure your testcase for application state
variables that are generated by the server "under the covers” in complicated web-based
applications. Mote that this does not cover data that was input by the user-- to configure user-
entered data please consult the Customizing a Testcase section of the manual.

The previous configuration for dynamic fields will be replaced.

Finish ] | Cancel

After the ASM wizard has Finished configuring your testcase, you may inspect the results of the ASM wizard

from the Fields View. The automatically configured fields will appear with a grey background, showing they
have been automatically configured.
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|c|'eate users x| 81641 bytes 395 sec

Title

Issue Tracker - Login [1]
Issue Tracker - Mo Projects
Project List

User List[1]

User List[2]

User List[31
d 1

e I e e i

wme Headlers | B Errors| B Replay | 47 Search| &2 Engines | = Fields &3

Fields in web page: User List[2]

Mame Type Datasource
_EVENTARGUM Form field
_EVENTTARGET Form field
_ VIEWSTATE Form field User Varable #  VIEWSTAT..
binadd Form field User Variable #btmAdd

Size Duration
32,027 110
9869 039
6,332 008
71,227 038
9725 21
9.895 043

44125 sec elapsed

Goal Thir
6.000
6.000
6.000
6.000
6.000
6.000

Bl Servers| & Metrics| « Actors Content

Fecorded YValue

dDwtNDAYMDIZMTQ4030Q3802...

Create New User

Transaction
Object move
Object move
Object move
Object move

To override ASM's default handling of the field, simply right click on the field in the Fields View and select
"Edit". Simply change the Datasource to "Recorded" to reset the field to its recorded value without any

dynamic handling, or enter another datasource to send.

In addition to Form Fields and Application specific fields, the ASM wizard also manages state fields defined
by the web server, such as E-Tag and I[f-Modified-Since. These configurations are visible from the Headers

View:



e Heaclers 22 @ Errors| B Replay| 4 Search| 52 Engines| = Fields| B Servers| £ Me
Headers for: loadsofimages.html [2]

Request line and headers F
GET /loadsofimages.himl HTTP/1.1 F
Mame Datasource Fecorded Value i
PATH loadsofim ages.hin
HEADERS Accept text/himl, a
Accept text/html, applicati
Accept-Language en-us |
User-Agent Mozilla/5.0 (compa 3
Accept-Encoding gzip, deflate
Proxy-Connection YValue Keep-Alive
If-fModified-Since User Variable # If-Maodified... Wed, 27 Jun 2001 1
If-None-Match User Variable # If-None-Ma.. "273bbab39ffc0Lat _
4 . . I S I
Troubleshooting

The best way to determine if your application's getting the right values is to check your application state or
database. For example, if you run a test case that supposed to purchase a product, check your database to
see ifthere's a record of the purchase. If this shows there's a problem, the next step is to check your own
application's error logs for trouble.

Once a problem has been verified, the next step is to walk through the pages in the replay, looking for error
messages from the server. It may be useful later to configure validators (from the Validators View) to flag the
same errors again during further replays. If the error on the first error page in the replay suggests that the
cause of the error was not user entered data, but a hidden variable normally handled internally by the user's
web browser, then you may use the Fields View to track down any variables on that page that do not have
modifiers to update them automatically (if applicable). Once you have located a variable that is not being
handled automatically, and confirmed how the application automatically updates that variable, you may con-
sult the Advanced Application State section of the manual to give the Application State Management Wizard
enough knowledge to correctly update your scheme.

To disable automatic handling for certain fields when ASM is run, the Ignored Fields preference page may
be used.




Datasets

In Web Performance products, a collection of data that is used to dynamically change the actions of a test-
case is known as a Dataset. A dataset is a collection of tabular data, similar to a spreadsheet. After creating
a dataset, it can be used to customize the testcase.

In this example picture of the Dataset Editor, the dataset contains two fields (columns), Username and Pass-
word. It also has many rows, each of which contains values for the Username and Password fields.

g Ty
< Web Performance m =8
Lifespan I'u'-.-'el:u Page vI V¥ Reusable [ sharable Relu:uau:ll |
Username | Password *l
fiiebiser 3-0000 pbas J
\WehlUser3-0001 keqkq
Wehlser3-0002 nvsns
WeblUser3-0003 IFlsw
WeblUser3-0004 gooua
WeblUser3-0005 FFlnm
Wehlser3-0006 jrugs
Wehlser3-0007 qigei
WeblUser3-0005 wbfbn
\Wehlser3-0009 ijaic
YWebl ser3-0010 sahit b
A f | 3
Edit Fields... | Fil... |

Creating a dataset

Datasets may be created empty or imported from an external file. They may then be edited manually (cell by
cell) or entire rows may be filled by selecting the column (press the column header) and then the Fill... but-
ton.

Create a new dataset

In the Navigator view, the pop-up menu which appears from any existing dataset or the Datasets folders in
each repository contains a New Dataset item. Selecting this menu item will open the New Dataset dialog:
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Marme: | users

Fields:

LSEFMANmE add

password)|
Remowve |

(] 4 I Cancel

Enter a name in the name field and then press the Add button. You may then type each field name, sep-
arated by the <return> key to define the fields in the dataset. After pressing the OK button, the dataset will be
created with one row of sample data and the Dataset Editor will be opened. Values for each field can be

entered within the Dataset Editor.

Import a dataset from an external file

A dataset can be created using existing data in CSV or text format. From the Navigator view, select the
Import item from the pop-up menu on any dataset or the Datasets folder. Selecting this menu item will open

the Import Dataset dialog:



1. Choose the file to import x|

2. The file may be imported into either a new or existing dataset o e T —— _|
3. Choose the field separators. For CSV files, choose comma. This ~ MMPertfremfie: @ TR
example uses tab characters between each field.

4. By default, the import process will automatically remove any o, datas‘Et@'Da“SE“

leading and trailing white-space from each entry. This feature may (" Existing datas® |- *I

be disabled when needed.

5. If the first row of the imported file contains the names of the Field separatnr(s)—@

fields, enable the "Use first row..." option. The import process will W comma i) T tab(ie) [ space ()
create a dataset with matching field names. If not, field names will I semicalon ;3 [ bar ([}

be generated. They can be edited later in the Dataset Editor. other characters:|

6. If your file contains characters that are escaped, you may select
this option to parse them as escaped characters. This is useful if
you must import values which span multiple lines. Simply ensure
that in your file, each row in the dataset appears on it's own line,
and that line breaks within individual values are replaced with the

¥ Trim leading and trailing spaces @
I Use first row Far Field names @
¥ Parse escaped characters (i, i, ir, ekc) @

i . ~ Preview
characters "\r\n" (or an appropriate new line sequence for your
) ] . ] " Isername | Password |

application server). Once imported with the "Parse escaped char- bl agt 30000 ¢ kpbas
acters" option, tooltips over each dataset value will display the com- Webllser3-0001 kegky
. . Wehllser3-0002 nvsgs

plete value with line breaks. Wehllser3-0003 Flsy
7. As the import options are selected, the Preview section will dis- webUser3-0004 gecua
play what the first 10 rows of the dataset would contain if the cur- ieblser-0005 FFirm
) Wehllser3-0006 jrugs

rent settings were used. Wehllser3-0007 gigei
Weblser3-0003 whfbn

Ik I Cancel

Refreshing imported datasets

While the Dataset Editor provides a convenient interface for editing the values in a dataset, there are times
when it may be more convenient to modify the data with external tools (such as a database query). After a

dataset has been imported, it may be re-imported easily from the Navigator pop-up menu (Reload item) or
the Dataset Editor (Reload button). The original settings will be remembered and re-used automatically.

File Uploads

If the application includes an operation involving the upload of a file from the users computer to the server, it
may be desirable to provide different files during a simulation. Configuration to simulate the upload of dif-
ferent data files during a load test is broken down into three steps:
1. Import the data files you would like to use during a load test into Load Tester.
2. Create a dataset of filenames specifying the specific files that will be used for the load test.
3. Create a modifier to have the Virtual User replace the recorded file content with one of the selected
files during playback.



Importing files

A predefined set of files must be imported into Load Tester through the File Uploads preferences page. This
page may be accessed from the menu: Window » Preferences » Web Performance » File Uploads .

g
“ Preferences @

|type filter text | Available files for upload
+- Help
InstalfUpdate My Upload. pdF add File(s) |
-I-Web Performance _
Baseline Repart Remove filefs) |
+l- Browser Refresh |
Client Certificates
Diagnostics enerate Dataset |
File Upload
Licenses
Load Teskt
Load Test Report
Performance Goals
Proxies
lsage
Restare Defaulks | apply |
Ik | Cancel |

Once on the File Upload page, you may select the "Add file(s)" button to select files for Load Tester to keep
available for use during a load test. Each file will be copied into a private location from which they may be
synchronized with any remote load engines in use prior to a load test. If a file is changed after adding it, the
"Add file(s)" button may be used to replace the copy used for load testing with the updated copy.

Creating a Dataset

The simplest way to create a dataset is from the same File Uploads preferences page described above. By
selecting the "Generate Dataset" button, Load Tester will offer to create a dataset of all the files currently
available using the repository and names specified.

Alternatively, if the intended load profile consists of different test cases where some files may be used in one
test case and not another, then it may be necessary to customize a dataset to specify the subset of files that
should be used. Please see Create a new dataset for more information.




Creating a Modifier

Once files have been successfully imported and a dataset prepared, we will be ready to proceed to the
Fields View to locate a file upload to be updated.

Wr Headers | @ Errors | =) Fields &2 B Replay| v Actors| 4 Search| B Servers| &3 Engines| Z£ Metrics| [E Content = B

Fields in web page: Neevia.com - Online Decurment Converter Choose customization:
Mame Type Datasocurce Recorded Value Transaction Title i
jResclution FermField 300 Object mowved [1]
|Rotate FormField PageByPage Object moved [1]
myFile FileUpload D434, Object moved [1]
o1 FormField zRGE Object mowved [1]
outF FormField PDF Object mowved [1]
ownerpwd FormField Object moved [1] =
r 1 3
Filter: u | Search: s | |RE | 74 Loaded - 45 Shown - 1 Selected -

Sort: [Mame (FWD)]

Editing a file upload field is similar to editing other fields. The first step will be to configure the value, which
contains the file contents. To use the files configured above for the content of the file upload, choose a File
upload datasource. You will then have the opportunity to choose a source for the name of the file to use as
the content. By default Load Tester will select a Dataset source, which is the most common method. Then
choose the dataset and field that contains the filenames:
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Edit field

Choose a datasource for the field

m}"FIlE Datazource Encuding

Name Iﬁ Recorded Value Dida;+-4..
Value i
Filename Datasource ’Fiie upload e ']

Choose a source for the name of the file to upload:

(Files should be uploaded into Load Tester first -| SEE File Uploads under Window > Preferenc

Datasource ’Dataset v]
Dataset: |Files ~
Field: |filename :

| ok || Cancel

When editing the modifier of a file upload field, the Field Editor dialog will show a Filename part, in addition
to the name and value parts. The Filename part of the field can be used to configured to change the name of
the file sent to the server, if required. This may be the same dataset field as specified above if just the name
of the file (excluding the path name) is sufficient, or an alternate dataset field containing a complete file

name may be used. In many cases, the server will completely ignore the filename sent - in these cases the
Filename part can be left as a recorded datasource.
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Edit field

Choose a datasource for the field

m}"FIlE Datazource Encuding

Mame

Recorded Value Mitesh Resume.doc

Value I : I :
Filename Datasource ’Dataset ']

DataSet: [F'ms

Field: |filename

| ok || Cancel

Content Modifiers

Configuring replacement of part content is performed from the Fields View. If an HTTP request contains the
content-type multipart/related, it is displayed in the Fields View with type part. For other styles of HTTP

requests, such as those that post a single raw content block, that block will be displayed in the Fields View
with type Message body.

r’ Conte (“"”‘ Heade |/E Errors | = w ﬁq i b= Heplaw v Actorw & Searcw =

Fields in testcase: Check balance

Double clicking on the field opens a

dialog where the replacement data is spec-| | Name
ified.

Type Datasource Recorded Value
(POST content) Message body <request> < operation>login:
(POST content) Message body «request> < operation> get:b




The replacement configurations allowed are:
1. Replacing the entire content of the part from a file or dataset field.
2. Replacing multiple smaller sections of the part from datasets or user variables.

Partial content replacement

If only some sections of the field require replacement, double-click the field or choose Edit... from the pop-up
menu in the Fields view.

Adding the modifier

@ S =

Edit field

Choose a datasource for the field

(POST content) Datasource | Encoding

Open the Field Recorded Value <request> <operation>login</operation> <u

Editor dialog and Datasource |F‘.ecmded "I

select the Text with

. Recorded
replaced regions User variable
datasource Dataset

Text constant

Text with replaced regions

Concatenation

2] 0 b File upload
Transform
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Edit field

Choose a datasource for the field

(POST content) Datasource | Enceding

Recorded Value <request= <operation=login</operation> <username:

The dialog
changes to display
the content - the
lower text area is
used to select the
sections of text to

Datasocurce ’Tmrt with replaced regions v] I :

A E -
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Removing a modifier
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from the Fields-
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Entire content replacement

When replacing the entire content during a load test, the files to be used for data replacement can be spec-
ified in a dataset. The files must be imported into Load Tester through the File Uploads preference page.
See the section on uploading files for a detailed explanation on using the preference page and creating a
dataset.




Adding the modifier
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After pressing OK, the new field con-

. . . . . Mame Type Datasource Re
figuration is shown in the Fields View: hih _ _

(POST content) Message body  File upload Dataset uploads:filename <

(POST content) Message body <

Removing the customization
To revert the configuration of the field to the recorded value, re-open the dialog from the FieldsView, select

the Recorded datasource and press OK.

Replaying
Replaying

A Replay is a simulation of a person using a browser to interact with a website. The pages visited are
defined by the Recording being replayed. After each page is completed it will be selected in the Testcase
Editor and displayed in the Content View (unless in Fast Play mode). The Content View will automatically
be activate when a replay is started.

Configuration

Prior to replaying a testcase for the first time, Analyzer will inspect the testcase for parts that cannot be
replayed exactly as they were recorded. Then the Testcase Configuration wizard will display the rec-
ommended configuration steps. In most cases, the recommended steps should be followed.

This wizard can be re-run anytime by selecting Configure->Testcase option from the pop-up menu on the
testcase (in the Navigator) or from the Configure toolbar button when a testcase editor is selected.

User Identity

If a replay should be performed using a different identity (e.g. username & password), the User Identity wiz-
ard will lead you through the steps for re-configuring the testcase to use usernames/passwords from a list. If
NTLM or HTTP authentication is detected, the User Identity wizard will perform the necessary configuration

steps.
If you wish to re-run the User Identity wizard later, select the testcase (in Navigator or Testcase Editor) and

choose the Configure->User Identity option.




Application State

Many websites use dynamically-changing parameters in URLs or form fields. These testcases cannot be
replayed exactly as recorded. The Application State wizard analyzes these fields and determines the most
likely sources for these variables.

If you wish to re-run the Application State wizard later, select the testcase (in Navigator or Testcase Editor)
and choose the Configure->Application State option. This wizard will lead you through the steps for re-con-
figuring the testcase as needed. Some choices can be overridden - see the Application State section of the
user manual.

Controls

For a walk-through of the basic process, see the Replay a testcase section of the Quick Start Guide. A
replay can be initiated from the Play (¥ ) button and stopped with the Stop (®) button from the toolbar:
@ B b W 00 k0 Ee
Replays are performed using the selections under the Recording menu or the corresponding toolbar but-
tons. When any of the replay options are selected, the testcase being displayed in the active editor window
will be replayed. If no editor windows are open, the testcase currently selected in the Navigator View will be
replayed. The replay actions available are:

@ Record - Starts recording a new testcase

@ Stop - Stops the replay and cancels any outstanding transactions.

P Play- Replays the testcase including pauses between page selections ("think time").
¥ Fast Play - Replays the testcase without think time between pages.

Ul Pause - Pauses the replay after the completion of pending transactions. The replay may be restarted
using any of the other buttons.

¥ Single Step - Replays the next transaction in the recorded testcase and pauses once the transaction is
complete.

M Page Step - Replays the next page in the recorded testcase and pauses when the page is complete.

Once areplay is started, it is associated with the original testcase and is displayed in the editor window (if
the editor for the testcase is open). In order to view a specific replay, select the entry from the pull-down
replay menu at the top-left of the editor window, as shown below. To delete and rename replays, select the
Edit Replays... item from the menu.
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Replay status

The current status of the replay will be displayed in the Status View.
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More detailed information about a replay is available in the Replay View.
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A detailed log of the replay is available in the Event Log view.

Phase Three - Large Scale Tests

Phase Three Testing Procedure

Phase 3: Full Scale Load Testing

A full-scale load test consists of generating an increasing number of virtual users while measuring both
client and server-side metrics. The resultis a set of metrics that can be used to estimate the capacity of the
system under test, and point the way to look for performance improvements. This stage can be repeated as
necessary as changes are made to the system under test.

One area of interest is performance enhancement and code tweaking. While our performance testing con-
sultants can suggest places to look for improvement, however, individual systems require the appropriate
domain experts. For example, an Oracle DBA would be required to tweak the performance of stored pro-
cedures, while a .NET performance expert would be required to profile and modify .NET code.

Prerequisites

How Many Users to Simulate

A description of the load to generate must include how many users to start with, how many users to add in
each time interval, and the end testing goal. Example:

“The test will start with 50 users, and add 25 users every two minutes until the goal of 500 simulated
users is reached”.

Load Profile Description

A “load profile” is a description of the mix of test cases and bandwidths to be simulated. For example, if the
application consists of two tasks, a load profile might be described as “40% test case 1 at DSL speeds”, and
“60% test case2 and modem speed”.

Usernames & Passwords

If each virtual user must have a unique identity, a large number of usernames and passwords must be con-
figured in the system under test. For example, to maintain 100 concurrent users for 30 minutes when the test
case lasts for 5 minutes could potentially require 600 usernames and passwords. (Each level of con-
currency would repeat six times (30/5), which would be duplicated across the 100 concurrent users.)

Test Case Development
Any additional test cases needed for a complete test need to be completed and tested.
Client Access

A client representative must be available to monitor the correct operation of the tests as they run.



Execution

« Execution of Phase Three starts with configuration of a load test using the parameters specified in the
prerequisites.

« Next the testis actually performed

« Finally, the test results are analyzed in a report

Deliverables

« A full performance report including a “how many users can your website handle” analysis.
« Recommendations for improving performance.

Load Testing
Configuring a Load Test

The first step in configuring a load test is to select a test case, and use the right-click menu to select New
Load Configuration:
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The goal of a performance test is to determine a relationship between the number of virtual users and per-
formance. In order to do that, you'll want to describe a ramping number of virtual users and observe the
changes in performance relative to the number of users.

This section of the GUI allows the user to describe the performance test in terms of the starting number of vir-
tual users and how frequently to add new virtual users. A typical value is between 1 and 50 virtual users.
The "increase by" value is how many virtual users to add in a period, usually between 1 and 5 minutes. Typ-
ically this value ranges from 1 to 50.



It is best to start with a low number of users and verify the correct operation of your server before per-
forming tests with larger number of virtual users.

The test configuration below shows a test that will run for 4 minutes, starting with 50 users, and increasing
by 50 users every minute. While the estimated maximum users that can be simulated by this configuration is
shown as 200, the number of virtual users you can simulate is limited by the speed and memory of the play-
back machine, so that the actual number of virtual users generated is potentially lower than the value in the
"potential” field.

[ Load Configuration [1] & =
Test Duration Virtual Users
@ Run for 4 minutes v  Startwith 50 ~| users
Run maximum repeats = =] .
V| Increase b 50 ~ usersover 1 < |minutes ¥
. y mssennl |,
Data Collection [
_ - : : — Start
Sample period 10 + |seconds ¥ every 2 \M @
V| Detailed Page Durations M ST Ll | EER T
ore...
v | Individual URL Metrics 100 maximum users
Select testcase to add... ~ |+ =
Testcase Weight % Speed  Think Time VU Start Delay Repeats
recording [4] 100  100% 5Mbps  Recorded Random 1 n/a
Test Length

Duration can be specified in units of hours, minutes, or days. The duration of the test should change depend-
ing on your testing goals. If you are just trying to get an idea of the speed of certain operations on your site,
useful performance information can be gained for tests that are a few minutes long. You can then tweak
parameters in scripts or machine configuration and see if it has an effect on performance. If, however, you

are trying to stress your web site to see if anything breaks, you'll want to run the test over a longer period of
time.

Alternatively, it is also possible to have a test stop after repeating a fixed number of times. This approach
allows the test to continue running for as long as the server requires, until the test has been attempted at
least as many times as specified in the limit (or until the test is stopped by the user).



Multiple Test Cases

More than one test case can be run simultaneously by adding them to the table. To add a test case to the
table select the test case with the pulldown box and then click on the plus "+" sign. The distribution of test
cases is determined by the "Weight" column. For example, if you were going to simulate 100 virtual users,
and wanted 20% of the load to be from test case 1, and 80% of the load from test case 2, you would put a
weight of "20" for test case 1, and a weight of "80" for test case 2.

Network Simulation

The "Speed" parameter describes the network bandwidth of each virtual user in the simulation. No matter
what network configuration was used to record a test case, this setting controls the simulated network con-
nection. For example, if the "Speed" parameter is set to 128 Kbps, that means the peak data transfer by
each individual simulated user will not exceed 131,072 bits per second. (128 x 1024). This implies that if
you recorded a business case over a local LAN, playing that business case back at modem speeds will take
much longer. The implications of the effects of bandwidth can be studied by running a Baseline Per-
formance Report.

Sample Period

The sample period is the length of time over which metrics will be sampled before saving the values. For
example, if the sample period is 15 seconds, the Metrics views showing the results of a test will have values
every 15 seconds. This value should be shorter for short tests, and longer for long tests. For example, if your
test only lasts an hour, then having samples every 10 seconds makes sense. If, though, your test is intended
to run overnight, then the sample period should be much longer, in the area of 5 minutes. This helps make
the data easier to interpret. When running extended tests, Web Performance Load Tester™ will collect large
amounts of data - which could cause the program to run out of memory and halt the test prematurely. As a
rule of thumb: when running a test for multiple hours, you should have sample periods that are on the order
of minutes, while short tests can handle sample periods as small as 5 seconds.

For more information, please consult the section for the Load Test Configuration Editor.

Running a Load Test

To run a load test start from the Load Test Configuration Editor and click on the Run Button. The following
view will appear:
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This is the Load Test Results View, and will show you the test metrics being generated in real time. These
metrics can be confirmed by simultaneously running a separate monitor on the web server(s) such as the
Windows Perfmon utility. Keep in mind that the metrics from multiple web servers and Load Engines are
being combined for you to give an overall performance picture.

While the testis running you'll want to monitor the performance of your web servers using the Servers View:
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Itis also important to monitor the performance of the computers generating the virtual users in the Engines
View:

.,
m-:ntent Headers | Errors | Fields | Replay | Actors | Servers | Statiskics =0

Current engine configurakion —CPL 2 Ukilized
Marmne | Stakus | Color | |Isers | Capaciky | “aiZPU | %aMern | 100
192.168.1.70 de N 0 100 0% 0%
e 0 100 0% 0%
local Idle ] 100 3% 28% C0 \
N
0 A . "'-'I I .’\""“'.,-Ilal'.«L

00:13:31 00:15:31
—Memory % Ltilized

100
50
4 3
| | 3 - . .
Add Engine | Rermove | Configure IPs | pgrade | [+ Show Live Data 00:13:21 00 15: 21

One of the major features of the software is it performs load balancing among the computers generating the
virtual users in order to make sure the simulations are accurate. A computer that is overloaded with too high
a CPU utilization or low memory can't generate an accurate simulation. Toward this end, even with a single
computer the algorithm may limit the number of virtual users that can be added. For example, you may



specify that a test add 50 virtual users every 1 minute, but if the computer you are using can't handle that at

the moment, a smaller number of virtual users may be added.

Analyzing Load Test Results

To analyze the results of a load test click on the Reports Button from the Load test Results View:
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The report can also be accessed in the Navigator View by double-clicking on a completed load test, or by

right-clicking on a test result and selecting the "Open Test Report" option.
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The Load Test Report view will be displayed:
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The contents of the report are designed to be self-explanatory - they include text surrounding the graphs and
charts to explain their meanings.

Advanced Configuration Guide

Advanced Testcase Configuration

The Web Performance wizards have been developed to automatically configure testcases for the majority of
web-based systems -- especially those based on popular application frameworks. However, some appli-
cation frameworks and custom-coded applications use techniques that are not (yet) recognized by the wiz-
ards.

The goal of this tutorial is to help you determine what part of the testcase needs further configuration and
demonstrate how to make the necessary changes.

Before beginning, itis important to note a few points:



« Determining exactly which part of the testcase is not yet configured correctly may require detailed
knowledge of the application -- itis a good idea to get the application developers involved.

« Ifa working testcase is not achieved at the end of this tutorial, please contact Web Performance sup-
port for further assistance.

« When you achieve a working testcase, please consider submitting it to Web Performance support with
a description of the configuration changes required to get it working. This will help us improve our auto-
matic configuration wizards.

Overview

This process usually involves 3 steps:
1. Find the exact cause of the problem
2. Analyze what needs to be different in the underlying HTTP transactions to fix the problem
3. Make the necessary configuration changes in the testcase

The next three sections of the tutorial will describe these three steps in more detail and give some hints on
how to accomplish them.

The remaining sections are examples of solving some specific problems with various combinations of the
techniques described.

Finding the problem

When searching for the source of the configuration problem, you should start by using the Replay feature,
rather than running a load test. When performing a replay, the software will save all the content received
from the server (much like a recording), allowing you to review the content of each page and inspect the
details of each HTTP transaction. This will be critical in identifying the problem.

There are cases where replays work but load tests do not. When a load test with only 2-3 simultaneous
users fails, the cause almost always falls into one of these categories:
1. User identity or authentication - multiple simulated users are attempting to use the application using
the same identity and the application does not support this.
2. Shared user data - the simulated users are attempting to operate on the same data. Either the oper-
ation is blocked by the application or the actions of one simulated user makes the actions of another
simulated user erroneous or impossible.

When a load test succeeds with a small number of simultaneous users but fails when more users are run-
ning - the problem is almost always the application and/or the server. Don't be surprised - that's the point of
load testing, right?



Finding the problem in a replay

In order to get the testcase configured correctly, you must identify the first transaction in the testcase where
some symptom of the problem is displayed. This will frequently be a web page that:
« causes a validation or extraction error in the Web Performance software
displays the wrong content
display an error message
« response has a different status code
« fails to return a valid response

Sometimes the test will run normally and indicate no errors but the testcases are not producing the desired
results - e.g. a testcase that simulates purchasing an item does not generate any record of the purchase in
the system.

Examples of the above situations:

Errors generated

When a replay cannot be completed successfully, the Replay View will indicate how far the replay prog-
ressed before errors were encountered:
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Checking the Errors View will usually provide more information about the problem:
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Different Status Code Returned

Automatic validation is performed on the status code of each transaction and in most cases it is expected to
be an exact match to the recording. There are some exceptions that the logic will allow automatically. When
a problem is detected, it will appear in the Errors View:
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Fails to Return a Valid Response

On occasion the error will be so serious that the server completely fails to return any response and closes
the connection. Most of the time, this is caused by server overload, but occasionally it is caused by server
application errors when unexpected inputs (due to a incorrect testcase configuration) are received by the
server.

‘Content| Headers ﬁm\ﬁelds Replay | Actars | Servers | Statistics | Engines @~ = 0]
1274 errars in test results: 11/3/06 1:26 AM Load Configuration [1]
Time | Descriptian | Transaction Title =
100554 Connection closed upon request, stepdActve.gif
00:05:54 Connection closed upon request, ConsumerBooking.gif
00:06:02 Connection closed upon request, Fage.css
00:06:02 Connection closed upon request. stepdactive.gif
00:06:0G Connection closed upon request. Default.css
00:11:148 Connection closed upon request. du’ home
00:11:29 Connection closed upon request, du', sme booking
o an-11-an B Mranmactinn clocad noe rannoet | NEEren schnica nif _*lll

Wrong Content Displayed

Inspect each page of the replay in the Content View to determine if the page appears to be correct. Each
page will generally be a close (if not exact) match to the page from the original recording. Does the page
look like the result of a different operation? For example - the login page is returned when another page is
expected.

Error Message Displayed

In this example, the server returned a page indicating that the request could not be completed:
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Analyzing the required changes

This step will frequently require a more thorough understanding of the application then you may have
needed before this point. It is often most expedient to enlist the help of an application developer at this point
in the process.

The goal of this phase is to determine:
1. Where is the incorrect data?
2. Whatis the correct data to send?
3. Where does that data come from?

Step 1 - Where is the incorrect data?

More specifically - which part(s) of which transaction(s) does not contain the correct values?

You must start by identifying the transaction that is not configured correctly. More specifically, which HTTP
request is not sending the correct data? In many cases, this will be the same transaction that displays the



problem symptoms. If not, the transaction will be earlier in the testcase - you will have to track backwards in
the application to find the source of the problem.

For example, if you have seen an error from the Web Performance software like this:
Page did not contain required variable(s): #xname

The related page is the first place that the Web Performance software has detected a problem, so this is the
first place to look. Did this transaction receive the expected page in the response? If "yes", why was the var-
iable not in the page? If "no", why was the correct page not returned? Was something in the request (URL
query parameter, cookie, form field) incorrect? The answers to these questions, with the help of the appli-
cation developer, should lead you to discover what piece(s) of data in the request(s) are in need of further
configuration.

Step 2 - What is the correct data to send?

Once we have located the incorrect data - we can then determine what the correct values should be. In
some cases this will be obvious. In other cases, the application developer may be able to help.

One of these two cases will apply:
1. The user would have provided this data
2. The server provides this data

There are a few exceptions to the above:

« Some data is randomly generated by scripts within the
page. In this case, since the server will generally accept
any value, we will consider it "user" data, even though
the end-user did not actually enter this information.

« With some testcases, you may find that the problem
occurs in transactions that are not required for the test-
case. The click-tracking URLs found on many large por-
tal websites or e-commerce websites are a good
example - the testcase does not required these URLs to
succeed - and in many cases these URLs are unde-
sirable for the testing process. You can use the Trans-
action Blocking features to eliminate these transactions
from your testcase during the recording phase.

If #1 applies, then the values must be provided by you in the form of a Dataset. This data may be generated
(such as random or sequential values) or imported into the dataset. The appropriate values is entirely
dependent on your testcase and the details of the application implementation. Either the test designer or the



developer will have to make that decision. The Datasets page describes the process for creating datasets
and the Fields View page shows how to substitute data from a dataset into a field entered by the user.

Step 3 - Where does that data come from?

If the data did not come from the user, then it must have come from the server. The browser doesn't "make
things up", so with the exception of randomly generated data in scripts, everything else must come from the
server. The ASM wizard will automatically locate many of these. When it does not, you must locate that infor-
mation and either:

1. Manually configure extractors and modifiers

2. Provide a custom rule that will help the ASM wizard find and configure this data automatically.

But first you must find it.

If the application developer cannot tell you where the data comes from, you can use the Content View (par-
ticularly the text tab) to inspect the source HTML of each page returned from the server during the recording.
Note that many modern web applications receive significant amounts of their data in plain-text or XML for-
mats that are retrieved by Javascript, rather than the source HTML of the pages. Be sure to look in those
transactions, as well!

When you have located the data that causes the problem, then you can proceed to the next section to con-
figure the Web Performance software to handle it.

Testcase Configuration

Once you have determined which piece of data is causing the problem, you can decide what to do about it.

The solutions generally fall into these categories:
1. Remove the entire transaction from the testcase
2. Ignore the field during automatic configuration
3. Find and configure the source of a dynamic field
4. Find and configure dynamically-named fields

Remove the entire transaction from the testcase

For complex or portal sites, there are often many transactions that come from systems that are not intended
to be part of the test.

For example: tracking URLs (used for user activity) and URLs from advertising sites (for banner ads) should
frequently be left out of the test altogether.

Any transaction that is not required for the correct operation of the testcase and comes from a server that is
not being tested (or the URL has negligible performance impact) is a candidate for this technique.



Note: The term fransaction in these documents always refer to
a single HTTP transaction, which corresponds to a single
request/response between a web browser and a web server. It
should not be confused with any concept of a transaction in
the web application, such as making a purchase on an e-com-
merce site.

Once you have located the URLs or servers to be ignored, they can be removed from the testcase manually
by deleting the undesired transactions. Be sure to run the configuration wizards again (especially the ASM
wizard) to update the testcase configuration. Failure to do this can cause errors during replay. You may also
use the Blocking preference page to block these transactions from being recorded and then re-record the
testcase. Note that during the recording process, these transactions will still pass between the browser and
server - they will simply be left out of the testcase.

Ignore the field during automatic configuration

Some fields are detected by the ASM logic as dynamic when they are not. Frequently there are fields that
could change in various parts of the application, but not for the particular testcase being simulated. This
causes extra work for the load testing tool and potentially misleading errors during a test if the fields do not
appear in the page during a replay or load test.

To disable dynamic handling for a field, use the Fields View, to locate the field. By right clicking on the field
and selecting Edit, change the Datasource for the field to "Recorded" to always send the recorded value,
rather than attempting to handle the field dynamically.

Once this technique has been determined to be useful for a field, you may use the Ignore Fields feature to
permanently ignore a field during the ASM analysis.

Find and configure the source of a dynamic field

Some fields cannot be automatically configured by the ASM wizard because it cannot find the source of the
field. This is frequently the case when the fields are assigned a value by a mechanism other than using the
value parameter in the field declaration tag (e.g. javascript) or for query parameters in URLs that are gen-
erated dynamically in the browser (e.g. javascript).

The next section, Configuring Dynamic Fields, shows an example of the configuration steps required to
address this situation. The Web Service tutorial also demonstrates a solution to this problem.

Find and configure dynamically-named fields

Some applications use an architecture that results in the same fields having different names each time the
testcase is performed. These fall into two categories:

1. Fields with name dependencies

2. Fully-dynamic file names



Case #1 has groups of fields where a portion of the field name is equal to the value of another field. For
instance:

ITEM=123
FNAME123=Bob
LNAME123=Jones
ZIP123=44095

ITEM=456
FNAME456=Jane
LNAME456=Smith
ZIP456=76012

In the above example, the names of the FNAMExxx, LNAMExxx and ZIPxxx fields are dependent on value
of the preceding ITEM field. These fields can be handled automatically using the Dynamically Named Fields
feature, described later in this tutorial.

Case #2 has two variations:
1. The name of the field can be predicted in advance
2. The name of the field essentially random - it can not be known in advance

If #1 applies, then the field name can be supplied in a dataset and manually configured with a modifier in the
Fields View.

If #2 applies, the testcase will require customization that is beyond the scope of this tutorial. Please use the
Support wizard to send the testcase to the Web Performance support system. The support personnel can
help you arrive at a working configuration.

Configuring Dynamic Fields

Once you have determined what values need to go into which fields, and where it comes from, there are two
ways to configure the testcase - manually and automatically.

« Manual configuration - This involves configuring a modifier and an extractor to move the data from a
response to a subsequent request. This is a good way to handle simple cases and to validate a pro-
posed solution before attempting to create an automatic configuration. However, if a similar change
needs to be made for many transactions and/or for many similar data elements, this can be a lot of

work.
« Automatic configuration - This involves creating a rule that the ASM Wizard can use to automatically

locate the data and configure modifiers and extractors as needed when the wizard is run. Thisis a
good way to handle cases where the same data needs to be extracted/modified in multiple



transactions (such as session identifiers) or there are multiple fields that are expressed in the same
manner. It can be a little more difficult then a manual configuration, but generally saves configuration
time and effort in the long run.

Note that some situations can ONLY be configured manually and some can ONLY be configured auto-
matically. Additionally, there are some cases where neither manual nor automatic configuration is possible
via the techniques described here. Please submit your testcase to Web Performance support for assistance
in these cases. You can use the Support wizard to help automate the process.

Extractors, Modifiers and User State Variables
There are a few important concepts to understand before pro-
ceeding. When a request requires dynamic data that comes
from a previous response, there are two discrete steps:
1. extract the relevant data from the response into a user
state variable
2. modify the appropriate part of the request as it is written
to the server to contain the value from the variable

Terminology:

Extractors operate on a response. They look for a specific
piece of data in the response and place it into a User State
Variable.

User State Variable is simply a named place to store some
data. The User State Variables are (by default) reset each time
the Virtual User restarts a testcase.

Modifiers operate on a request. They change a specific sec-
tion of a request, as itis written to the server, to contain the
value from a variable or dataset.

Manual Configuration

Here is an example of a pair of transactions that require manual configuration. The response of the first trans-
action contains some information that needs to be extracted and saved for use in the second transaction -
the TAG_ACTION field. In this example, the javascript included in the source of the page will set the value of
the TAG_ACTION field to the value supplied as the second parameter to the javascript setField() method.
This value could be different each time the response is received - and must therefore be extracted dynam-
ically during a replay in order to supply the correct value for the next transaction. The source of the response
page is shown below:



Headers | Errors SERERS

Bl Content X Feplay Engines

Statistics

= [

Fields

= L U=l | ] Cantent far: Manuscript Central [1]

PORTAL=0&NEXT_PAGE=LOGINACURR « |

2l _*|;|L|

[

12| P o
F

LOAD_PROGRESS_FOFPUPESFAWN_EXFORT_MS_LIST_THREAD=Y&FIRS

p—

oupMamelifiselval =='3" JjavascriptsetField]{ TAG_ACTION', ™) javascript pop!

240 _FROGRESS_POFUREFPROGRESS_TYFE_ID="+FrogressTypeld+'&FIRE
ES5_FOPURPESHOWY _TRANMSFERING_TEXT=Y&FIRST_TIME_FL="&CL_IEREI

35 _POPURESHOW _CREATING_IMPORT_FL=Y&FIRST_TIME_FL=Y&CIURRET

siE

KML[TEH] Image| Haw|

HTMLAML | Text| Image | Raw |

figure 1: transaction 1

The request of the second transaction should contain the dynamically extracted value (from the first trans-
action) instead of the value that was originally recorded. Note that if the value was supplied as the default
value in the field declaration tag, the ASM wizard would automatically pick up that value, since that is the
standard way to provide the value for fields that are not user entered.
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figure 2: transaction 2



Step 1 - Configure the Extractor

In order to reliably extract information from a response, we must be able to tell the extractor how to locate the
data to be extracted. In this example it is easy, since the session identifier is surrounded by java-
script:setField('TAG_ACTION', 'and ');.

1. Open the Actors view (Extractors tab) and select the transaction containing the data to be extracted
(which must be in the response)

Press the Add Extractor... button ()

Complete the Prefix and Suffix fields

Enter the name of the user variable to store the session identifier in (e.g. action)

Verify that the correct value is shown in the Value selected for extraction field

abkwn

When these items are complete, the dialog should look like the picture below. When it does, you can press
the OK button to save the new extractor.
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When replaying this testcase, the Virtual User will run this extractor after the response has been received. In
this case, it will look for the target data (as configured above) and store it into a user state variable.

Step 2 - Configure the Modifier

In most cases, Analyzer will automatically parse the fields submitted with each request and they will be vis-
ible in the Fields view. Here is the TAG_ACTION field:
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Double-clicking the field or choosing Edit from the pop-up menu for the field will open the Field Editor
dialog. In this dialog, selecta User Variable datasource for the field value and enter the name of the var-
iable, as shown below.

Note that the variable name MUST be the same name used in the extractor configuration (above).

EoE ME
|| Edit field

Choose a datasource for the field

TAG_ACTION Datasource Encuding

Name Recorded Value LOGIN

WValue

l;']

Datasource ’ Uzer variable

Uszer State Variable name:  action




After these changes are complete, replay the testcase and verify that the new configuration changes have
the intended effect. If the testcase still generates errors, be sure to verify that this particular field is now cor-
rect - there are often multiple fields that need customization before arriving at a successful testcase.

Once you have determined that the manual configuration works as intended, you may wish to automate the
process by creating a custom detection rule, as described in the next section.

Automatic Configuration

The above example can be configured automatically in two ways:
1. Single-field configuration - automatically configure this EXACT case, i.e. the TAG_ACTION field
2. Multiple-field configuration - automatically configure any field that matches this usage pattern

In both cases, you must create a detection rule. This rule describes how ASM should locate the value assign-
ment for a given field name. More information on the configuration options for detection rules is available in
the Custom ASM Configuration section.

Both configurations are performed in the Detection Rules preference page. Go to Window->Preferences-
>Web Performance->Application State->Detection Rules.

Single-field Automatic configuration

Add a detection rule with the parameters as shown below:
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These parameters will create a rule that looks for matching values between provided the prefix and suffix in
web pages and attempt to match that value with the value of the named field (TAG_ACTION). Any places in
the testcase where a match is found, the ASM wizard will automatically configure the extractor and modifier

as demonstrated above.

Press the Test selected Rule(s) button to validate the configuration. Note that this step verifies that the con-
figuration is valid but not necessarily correct. In other words, it checks that the combination of parameters pro-
vided is allowed and the parameter names are spelled correctly, but cannot verify that the rule will have the
intended result.

Accept the changes (OK button) and run the ASM wizard on the testcase by selecting the Configure->Appl-
ication State item from the pop-up menu in the Navigator. Verify that the fields have been detected by the
wizard as required.



Multiple-field Automatic configuration

Using this method, you will create a detection rule that will apply to fields with different names but share the
same declaration format. For example, it would recognize the field value declarations for FIELD1 and
FIELDZ2 in these lines:

javascript:setField('FIELD1', 'value1');
javascript:setField('FIELDZ2', 'value2');

Add a detection rule with the parameters as shown below:

7 Detection Rules = -

Custorn ASM Detection Rules
The Application State Management Wizard detects and configures dynamic application state fields in your testcase using defaulk
rules, as well as custom rules, as supplied below,

Detection Rules | add Rule |

JMET {alt)

setFieldi Copy selected Ruleds) |
Import Rule. .. |
Remove Fule |

Rule Parameters
The kews and values entered here determine what detection strategy is used, and what that strateqgy is looking for, For maore
information abouk parameters that may be entered, please consult the user manual,

Pararneter | Yalue | Add Parameter |
detector.name setField()

deteckor wild Remove Parameter |
skring. prefix javascripkisetFigld™ {0, "

skring, suUffix "I

These parameters will create a rule that is very similar to the rule created in the previous step. The primary
difference is that instead of only employing this rule for a specific field name, it will apply the rule for any field
for which it cannot find a match using the default rules. In addition, the name of the field will be dynamically
inserted into the detection prefix and suffix so that the detection parameters can be specific as possible to
avoid false positives. The field name will be substituted into the prefix and/or suffix in place of the {0}



character sequence. Any places in the testcase where a match is found, the ASM wizard will automatically
configure the extractor and modifier as demonstrated above.

Unlike a single field configuration, the single quote character is reserved as an escape sequence. To force
the detector to match a brace (such as {), the brace may be surrounded by single quotes. If the detector
should match a single quote, then the quote should be doubled.

Press the Test selected Rule(s) button to validate the configuration. Note that this step verifies that the con-
figuration is valid but not necessarily correct. In other words, it checks that the combination of parameters pro-
vided is allowed and the parameter names are spelled correctly, but cannot verify that the rule have the
intended result.

Accept the changes (OK button) and run the ASM wizard on the testcase by selecting the Configure->Appl-
ication State item from the pop-up menu in the Navigator. Verify that the fields have been detected by the
wizard as required.

Dynamically Named Fields

Occasionally your testcase will include variables that not only have changing values during playback, but
also change in name as well.
Consider the case where two variables are posted to your application server:

serialno=1234
colorl234=blue

In this case, you may specify that the variable color1234 should be renamed, using a name derived from the
variable serialno each time the test is played back. In order to configure your testcase, you must configure
the "Dynamically Named Fields" preferences how to detect this behavior in your application. This option
may be configured through a preference page, accessed by selecting Window—Preferences... and then
selecting Web Performance—Configuration Wizards—Application State—Dynamically Named Fields.
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Configuring these fields is done in two phases. The firstis to select the "Add Field" next to the "Identifiers"
table, and enter the name of the field that identifies a value. In our example, the identifier is "serialno",
whose value will be used later to identify the name of the next variable.

Next, select the field in the Identifiers table to display the dependant fields associated with it, and press the
"Add Field" button next to the bottom "Fields" table to create a new dependant field. The name of the var-
iable may be entered here, replacing the dynamic part of the name with an ampersand (&). In our example,
the color field would be entered as "color&".

The next time the Application State Management Wizard is run on a testcase, fields starting with the name
"color", and ending their name with a value from the field "serialno" will be dynamically renamed when the
testcase is replayed or run in a load test.

More elaborate testcases can also be defined using dynamically named variables. Consider if our case had
been:

serialno=1234
colorl234=blue
weightl234 in lbs=5

1234 assembly date=20051201



Itis possible to specify multiple fields as having a single dependency by adding their names to the "Fields"
table:

o color&

« weight& in_lbs

o & assembly date
This configuration will allow the Application State Management Wizard to correctly assume name depend-
encies for all three dependent variables.
Itis also permitted for a dynamically named field to be associated with multiple identifiers. For example, con-
sider another case:

itemid=123456789
checkbox123456789=checked
legacyid=123
checkbox123=unchecked

To configure this case, simply create to identifier fields:

. itemid

. legacyid
Next, add the dependant field "checkbox&" to both identifier fields. The Application State Management Wiz-
ard will examine both uses of the "checkbox" fields, and only associate dependency when the name of the
field corresponds to the value of the identifier. In this example, the wizard will associate the first "checkbox"
field as being dependant on "itemid", and associate the second "checkbox" field as dependant on the field
"legacyid".

Ignoring Fields in the Application State Management Wizard

The Application State Management Wizard will attempt to automatically configure those variables shared by
the end user's Web Browser and the Application Server, but are not immediately exposed to the end user.
Generally, no further configuration is required in order for your testcase to play back successfully. However,
an easy optimization can be made to increase the number of virtual users supported by each load gen-
erating engine by removing those fields that never change. However, for large test cases, removing those
fields from the ASM Wizard may be an inconvenient approach.

The Application State Management Wizard offers ignore preferences in order to automatically ignore those
fields which are notintended to be treated as dynamic. These preferences may be accessed by selecting
Window — Preferences... and then selecting Web Performance — Configuration Wizards — Ignored Fields.
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This page contains two lists, one for omitting fields by name, and one for omitting specific uses of a field by
their value. For example, suppose your case contained a HTML fragment: <input name="btnSubmit"
type="Submit" value="submit" />

This may resultin a fixed value post being sent to your server:

btnSubmit=submit

You may always remove this value from the Application State Management Wizard manually, or you could
specify that this field always be automatically removed with either ignore list

Ignored Names Ignored Values

btnSubmit submit

Be very careful not to include a blank entry unless you intend for the Wizard to treat blank values as fixed
values as well. The next time you run the Application State Management Wizard, any usage with their name
or value specified in one of the ignore lists will be automatically ignored or hidden by the wizard.



Load Testing a Web Service

Overview

The purpose of this tutorial is to illustrate the steps required to load-test a web service using Web Per-
formance Load Tester. Although the demonstration service used in this tutorial is very simple, the concepts
presented are directly applicable to more complicated services.

This tutorial is organized into 4 main steps:
1. Create the testcase
2. Configure the testcase for replay
3. Configure the testcase for multiple users
4. Run test and analyze results

Introduction to the Bank web service

The service tested in this tutorial provides an interface to bank accounts. A similar service might be used, for
example, to allow ATM machines in bank branches to access accounts in the central bank system. The oper-
ations used in this tutorial are login and get-balance. These operations use a simple pseudo-XML format for
ease of readability.

Login transaction

The login transaction sends the username and password in a login operation. If successful, the response
contains a session identifier that must be used for future transactions. The XML sent and received in this
transaction look like this:

..
eaders Errors | Fields | Replay | Actors | Servers | Engines | Statistics | Dump wiew = O

=0 U0 el l@ Content For: <webpage> [1] l: E"J uﬂ
<requesk ;I <response = ;l
<nperation =login<operation = wresulk=1 < resulk =

<username>JAMES </username = <sessionid >341E42054 152044F5207A0351 74 1AAE 79 = sessionid =

wpassward =nkbromfr<fpasswaord = «fresponse

«frequest =

4 o o

HML | Test | Image | Raw | HTML ML | Text | Image | Raw |

Note that the above screenshot shows the content as viewed in Analyzer's
Content view.



Get-balance transaction

The get-balance transaction sends the session identifier and, if successful, receives the account balance (in
cents). The pseudo-XML sent and received in this transaction look like this:

.
eaders Errors | Fields | Replay | Actors | Servers | Engines | Statistics | Dump wiew =

(=l LI U] | ] Conkent For: <webpage:= [2] il Em uﬂ
<requesk = :l CrEspOnSe = :l
«operation:=get:balance </operation = <result=1 <fresult =

“egssionid =34 1E42054 152044F5207A031 741 AABTO <[ sessionid = +<balance>749=/balance =

«frequest = < fresponse

4 o o

HML | Tet | Image | Raw | HTML{AML | Text | Image | Raw |

In two example transactions show above, user "JAMES" logs into the system using the password
"nkbmmfn". The result value "1" in the response indicates a successful login and provides a session iden-
tifier to be used in future transactions. He then checks his balance and finds that he has $7.49 in his account
(749 cents).

Step 1 - Creating the testcase

The first step in the load-testing process is to create the testcase to be simulated. The testcase is a col-
lection of HTTP transactions (requests and responses). When testing a browser-based application, this step
is usually achieved by using the browser to interact with the website in the same manner any user would -
with the browser configured to use a recording proxy. This proxy records the HTTP transactions between the
browser (client) and server and creates the testcase using these transactions. If you have a client for your
web service and it supports the use of a proxy, this is the fastest way to get a testcase created.

Since many web services do not have this ability, we will demonstrate how to create the transactions from
scratch.

Creating the login request

The first step is to create the content of the request - that is the pseudo-XML shown above. Paste this into
your favorite plain-text editor and then save the file (e.g. login-request.txt). Next, note the length of the file -
this length will be needed when we add the HTTP headers.



Step 2 involves putting the HTTP start-line and headers into the request. Below on the left are the start-line
and headers used for this example request - the required headers may be different depending on the require-
ments of your service.

.
Contenk SHTTPES Errors | Fields | Replay | Actors | Servers | Engines | Statistics | Dump wisw = O
Headers faor: <webpage= [1]
Reguest line and headers Response (status) line and headers
POST fdemojfbank HTTR1.1 “E || HTTRI1.1 200 Ok |
Mame | M?l Yalue | Mame | Yalue
Hosk sy webperformanceine, com SErvEr apache-Coyokef1.1
Content-Type ket xml Set-Cookje JEESSIONID=394D0E70EYSE 169031 BE3S40C1ES1 1DS
ontent-Length 105 Content-Twpe | textfxml;charset=I50-3859-1
Content-Length 97
Date Man, 21 Aug 2006 021746 GMT
4| | *

Note that each part of the request headers will need modification as required by your service:
1. In the start-line, the path of the service will be different (/demo/bank)
2. The host should be changed to the hostname for the server your service resides on
3. The content-type could be different (text/xml is common)
4. The content-length must be changed to match the content you created for this request

The text file used to create the request shown above contains this:

POST /demo/bank HTTP/1.1

Host: www.webperformanceinc.com
Content-Type: text/xml
Content-Length: 111

<request>
<operation>login</operation>
<username>JAMES</username>
<password>nkbmmfn</password>
</request>

The other request and responses are created in a similar manner.

Once you have the 4 files created (a request and response for each of the 2 transactions), we can create the
testcase.

In the Navigator, select the Create Empty Testcase item from the pop-up menu on the Testcases node to
create a blank testcase where the transactions can be placed:
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We now have an empty testcase (renamed "Check balance"):
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The next step is to create the two transactions required for the Check balance testcase.

Each transaction can be imported (request and response) using the Import->As New Web Page item from
the pop-up menu in the testcase editor:
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Note that Analyzer groups transactions together in pages within a testcase.
For aweb service, there are no pages, so Analyzer will simply treat then as
one-transaction pages. In complex services that issue several groups of
transactions that are logically grouped and related, it can be useful to group
the transactions together within a single page. Analyzer will calculate sep-
arate metrics for each transaction and for each page, which can be useful
when analyzing load test results.

The request and response files are selected in this dialog:
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After importing both transactions, our testcase looks like this:
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Step 1 is now complete.



Note that the duration of the imported transactions is 0. Since
these transactions have not yet been analyzed with a live
server, the duration metrics cannot be determined. After a suc-
cessful replay has been completed, consider promoting the
replay to the base recording: Select the Promote button on the
Replay Properties dialog - accessible from the replay drop-
down at the top of the testcase editor.

Step 2 - Configuring session-tracking

Before we can execute this testcase in the current form, we have to handle the session-tracking used by the
service. We could replay the transactions exactly as we created them, but the service would fail on the sec-
ond transaction, because the replay would send the session identifier that we put in the transaction. Since
this session identifier has probably expired since we obtained it, the get-balance request needs to send the
new session-identifier from the login response.

Note that some services use cookies for session-tracking, much like a
browser. If this applies to your service and you can record it using the record-
ing proxy or you have imported real transactions captured in some other way,
the cookie headers might be in place and will be handled automatically by
Analyzer. In this case, this step may not be necessary.

Two steps are required to handle session-tracking for this testcase:
1. Extract the session identifier from the login response
2. Modify the session identifier sent in the get-balance request

To do this, activate the Actors view and select the login transaction in the testcase editor. The Actors view
will initially appear as below (empty).

p
Zontent | Headers | Errors | Fields | Replay M\Servers Engines | Stakistics | Dump wiew ﬁ* - = = 0

Exctractors for <webpage = [1]
Actions Taken |

ai=| Modifiers | 4 Walidators | Z=| Extractors




Press the Add Extractor... button () to add a new extractor - the resulting dialog allows configuration of the
extractor. In this case, we want to extract the session identifier which is located between the <sessionid>
and </sessionid> tags (delimiters) in the response. As these values are entered in the Prefix anchor and Suf-
fix anchor fields, the delimiters will be highlighted in the response content field in the lower third of the
dialog. If either delimiter cannot be located, an error will be indicated at the top of the dialog. If both the prefix
and suffix anchors are found, the target value for extraction will be displayed in the field at the bottom. Next
we enter sessionid in the Extract value in user variable field. This will create a variable in the user state that
will contain the session identifier when itis located by this extractor.

Note that if the delimiters appear several times and the first instance does not
contain the desired value, the Repitition number... field may be changed to
select the correct value.

>

Extract Yalue from Content

Please select haw vou would like the value o be located in a response during playvback,

 Anchars

This extractor will search the response for the fixed kext entered below, and extract the value located
between the bwo delimiters,
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[ Assume extracted walue is never URL Encoded

w Recorded Response
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< response =
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Cancel |




After pressing the OK button, the Actors view will show the Extractor like this:

i Ty
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Once the session id has been extracted from the login response, it should be dynamically replaced in the
get-balance request. This is accomplished by adding a modifier in the Fields view. Open the Fields view
and then select the get-balance transaction in the testcase editor (2nd transaction). The fields in the request

will be displayed as below.

-

Check balance X = 85
|Check balance 'I H9Z bytes 00:00.000 sec 100:00,000 sec elapsed EI
Title | Size: | Duration | Status | URL |

“wehpage = [1] 217 00:00.000 200 Rikkps f v, webperformanceine, comfdemnal,

B =webpage>=[2] | 275|  omooooo|  200{  htkpffwesss. webperformancein. comydemay. . ||

B Replay | v Actors | 4 Search | Z£ Metrics Content | B Servers | 52 Engines | @ Errors |7 Headers | = Fields &3

Fields in web page: <webpage> [2] CF
Mame Type Datasource Recorded Value
(POST content) Message body Partial replacement <request> < operation> get:balance< /operation:>
1| m
Filter: 5 | Search: w [ |RE | 11 Loaded - 1 Shown - 0 Selected -
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When a POST (message which sends content to the server) is in a format that is not recognized by Load
Testers parsers, it will list the field as a (Post content) field. Double-clicking the row will open a dialog for
configuring a datasource on the field. Since we only need to replace a small part of the request content,

select the Text with replaced regions datasource (1). The dialog will now appear as below. Highlight the

region to be replaced (2) and then press the Add (") button (3) to configure a datasource on that region.

- ? B’
Edit field

Choose a datasource for the field

(POST content) Datasource | Encoding

Recorded Value <request> <operation> get:balance</operation> <sessionid>34

Datasocurce lTE:d: with replaced regions v‘ @ @

<request> @ -
<operation> getbalance</operation>

I <sessionid=341E43054152044 F5207 AD31741 AABTI < /sessionid>
</request>

] Cancel

L

When all parts of the POST have been configured, press the OK button to save the changes.

With session-tracking configured for the testcase, the testcase may be replayed. Pressing the Replay button
(™) in the toolbar will invoke the testcase configuration wizard. This wizard is very useful for complicated



web applications but for simple web services itis frequently unnecessary. Select the Do nothing... option
and press the Finish button.

Eunﬁgure Testcase Check balance x|

Testcase configuration

The Following wizards will assist wou in configuring Testcase Check balance

The Fallowing wizards can configure wour test case For usernames & passwords,
session kracking, and dynamic variables, and can be re-run at any Eime, If vou have
no specific figld management requirements, the automatic settings are
recommended.

—authentication ) User Identity:
% Cnly use the login recorded

" Use different logins

= Session Tracking
¥ Configure automatically

™ Guided configuration

— Bpplication State Managment
¥ Configure automatically

" Guided configuration

¥ Do nothing fassume Testcase is configured as-is.|

< Back: [exh = | Einish I Cancel

After dismissing the Testcase Configuration wizard, the replay will begin. It will likely end very quickly, since
itis a very simple and very short testcase. When it is complete, open the Errors view and then select the test-
case to verify that no errors occurred during the replay. Then open the content view and select the get-bal-
ance transaction in the testcase editor to view the result:
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Checking the value of the session identifier we can see that itis different from the original transactions we
created - indicating that Analyzer was able to successfully extract the session identifier from the previous
response and modify this request to send the correct session identifier. Also note that the balance returned
is correct (we'll come back to this later in the tutorial). If you replay this testcase again, you should see a dif-
ferent session identifier with the same balance returned each time.

At this point we can declare success step 2 of this tutorial - we have configured the web service testcase so
that it can be successfully replayed.

Note that since the Bank demo service does not use true XML, the XML
viewers may not always format the content properly. In the screenshot
above, the plain-text viewer has been selected for both the request and
response content. Additionally, the tabs have been locked to prevent the view
from switching back to the XML viewer each time a transaction is selected.

Step 3 - Configure the testcase for multiple users

The key difference between the simple replay completed in the last step and a load test is volume. A load
testis simply a lot of replays, all happening at the same time. We could perform a load test with the testcase
right now, if we wanted. But it would not be a very accurate simulation of the expected use-case of the sys-
tem since the same person is not likely to be checking their balance simultaneously from multiple locations



over and over again. Instead we would like the load tests to simulate many different users checking their bal-
ance.

Creating test data

The first step in simulating multiple users is to create the list of users. For this tutorial, we will assume that
the system is already populated with accounts and we have the list of user names, passwords and current
account balances available to us.

Example users file:

username, password, balance
JAMES, nkbmmfn, 749
JOHN, ohgixm, 2913
ROBERT, gelslrjnja, 83801
MICHAEL, gfpgjxc, 2074
WILLIAM, nfowhth, 614
DAVID, hhjvksgue, 8365
RICHARD, rkipbo, 153

The next step is to import this data into Analyzer™. This is done from the Dataset node in the Navigator.
Select the Import... item from the pop-up menu and complete the import dialog:
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After importing the dataset, it will appear in the Navigator under the Datasets tree node and the dataset will

open to show the imported data:

'vH'Eh Performance Load Tester

=100 x|
File Edit - Repository  Record Play  Window  Help
|6 o a =@ | e - - b [0 B0 e B o
— Ty K'_| Ty
Tour |07 = O[] accounts &2 = 0
- D BankServiceDemo. wpt Lifespan ITestcase vI ¥ Reusable [~ Sharable Rel-:uau:ll |
() Testcases
SRESY Dol ascls USErname | password | balance |
- [ accounts JAMES rkbrmmen 749 -
i) Load Configurations I0HM ohigizm 2013
ROBERT qelslrinja 83801
MICHAEL qfpgjxc 2074
WILLIAM nfbwhfh 614
DavID hhjvksgue 365

Note the 3 settings at the top of the dataset editor: Lifespan, Resuable & Sharable. The Testcase lifespan
indicates that when a Virtual User (VU, or simulated user) selects a row of data from this data, it will use that




row until the end of the testcase. When a dataset resuable, the row may be used more than once during a
load test. When a dataset is not sharable, it can only be used by single VU at a time. The default settings,
shown above, are usually correct for a dataset containing the user identity.

Customizing the testcase

Now that the user identity information is available, the testcase may be customized to use it. Two modifiers
should be added to the first transaction to replace the username and password in the login request with
values from the dataset. This configuration is similar to the configuration of the session-identifier described
earlier in this tutorial:

Open the Fields view

Select the login transaction in the testcase editor

Double-click the modifier column (M?) and select the partial content radio button

Select the username in the Content text area, press the Add button (%7) and select the accounts data-
set and username field.

5. Repeat previous step for the password

N
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Edit field

Choose a datasource for the field

| (POST content) | Datasource | Enceding

Recorded Value <request> <operation>login</operation> <username>JAMES<

Datascurce [TEH‘IZ with replaced regions +

A E -
<request> -
<operation= login</operation=

I <username>JAMES«< /username:>
i <password>nkbmmfn-</password=
</request>

The testcase is now configured to use a different user identity each time the testcase runs. Replaying the
testcase, as described earlier, will allow you to easily verify this behavior. Each time the testcase is
replayed, a different username and password are sent in the requests and a different account balance is
returned. The following shows the get-balance transaction from the 3rd replay. You can see that the bal-
ance, 83801 matches the balance for that user in the dataset.
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Configure validation

Validating the results in this way is easy for a few replays, but is not practical for a load test. It would be more
efficient to have Analyzer automatically validate the balance returned in each testcase against the value in

the dataset.

To configure a validator, first return to the original testcase in the editor:
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Fiqurations

Next, open the Actors view and then select the get-balance transaction in the testcase editor. Then select
the Validators tab at the bottom of the Actors view. You will see the automatically-applied status-code val-
idator already present in the list of validators. Press the add button (<) to add a new validator.



Configure the validator to look for the account balance from the dataset in the response content by selecting
the Dataset field and radio button and then select the balance field in the accounts dataset, as shown below:
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After applying the validator, replay the testcase again and check the Errors tab to verify that no errors were
encountered. There should be no errors because our dataset accurately reflects the system being tested.

To see what the error looks like from the validator, the dataset will have to be changed to purposely have
wrong data in it. Open the accounts dataset and change the value of the first entry in the balance column
(double-click a cell to edit it). Before replaying, we will need the force the replay mechanism to reload the
dataset - to do this, open the Replay view and select the Reset Dataset State item from the drop-down menu
on the right side of the view:
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Replay the testcase again and then open the Errors view. The validation error displayed indicates that the
account balance that | entered in the dataset (749X) could not be found in the response content for the get-
balance transaction:

i : : . e —1 E“
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Don't forget to change the dataset value back to the correct value before moving on!

Step 3 is now complete - we can move on to running a load test.
Step 4 - Run load test and analyze results
Creating the load configuration

After recording, configuring and verifying each testcase, the next step towards a load test is to create a load
configuration. Select the Check Balance testcase in the Navigator and then select the Create Load Con-
figuration item from the pop-up menu:
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The default settings, shown below, should be fine for demonstration purposes.
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Running the load test

At this point, the hard work is done! Push the start button to start the load test.



The test will add 5 VUs each minute - if you are using a demo license, it will stop at 10 VUs for the last min-
ute of the test. When the testis complete, the results screen will look something like this:
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Analyzing the Results

The test results screen picture above, provides some basic metrics for monitoring the progress and state of
the test - most notably the number of Users, Hits/Sec and Errors. For a more detailed analysis open the test
report: press the Report... button on the results screen. In the first section of the report, you will see overall
metrics presented on charts such as the one pictured below. This chart shows that the total Hits/sec scaled
linearly as the number of users increased. This is a key measure of server performance and this test did very
well!
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A large amount of information is available in the test report at varying levels of detail. For a good example of
a load test report, see the website: http://www.webperformanceinc.com/load testing/reports/

Summary

In this tutorial we have demonstrated the basic process for testing a web service:

create the testcase

configure the testcase to handle session-tracking mechanism and test using the replayer
configure the testcase to simulate multiple user identities and test

configure the testcase to validate the result of the testcase

create a load configuration

run the test

analyze the results

NoOaR~WN =~

Good luck!
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Mailing List and Blog

To receive links to new articles, tutorials, load testing tips and occasional product announcements, sub-
scribe to our Mailing List or our Blog.
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FAQs
General FAQs

Q: How do I report a bug?
A: You can access our support-tracking system directly or submit an issue directly from our product using
the Support Request form from the Help menu. See the section on Getting Help for more information.

Q: When will you support other OSes besides Windows?

A: Our advanced server analysis module supports Linux, Solaris, and AIX. However, the Load Tester con-
troller only functions on Windows. We have no plans to provide new operating system support in the near
future, but if you feel that you need support for another operating system, consider contacting us via our
issue-tracking system.

Q: Analyzer created a repository for me automatically - where did it go?

A: By default, repositories are stored in the Workspace. If you cannot find it there, try re-opening Analyzer
and hover the mouse over the repository in the Navigator - the tooltip will show the complete path of the
repository file.

Q: | want to change where Analyzer stores my files and settings?
A: The files (by default) and settings are stored in the workspace. The Workspace section of the reference
manual describes configuration of the workspace location.

Recording FAQs

Q: | cannot record - what next?
A: Follow our Recording Troubleshooting Guide

Q: Why do | need to record some pages for Analyzer to analyze my website? Why can't it just scan my site
and test all the pages?

A: Analyzer is designed for complex transactional websites that have strict performance goals and are likely
to experience performance problems due to architectural, database or business-logic problems. Scanning a
website for all the pages is impractical in these cases.

Our initial product surveys indicated that analyzing a website in the "spider" manner has little demand - but
we are happy to be proven wrong! If you have this need, please tell us! You may vote for the feature request
in our issue-tracking system (see the support section of our website and search for "scan website").

Q: When | record with Netscape (or Mozilla, Firefox etc), the pages do not look right (or might even have
errors) in the Web Page tab of the Content viewer.
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A: The embedded browser uses the default browser for the platform - on the Windows platform, the default
browser is |E. Therefore, if your site returns content that is optimized for different browsers, the content dis-
played by the embedded browser (IE) will be the content that was optimized for the browser used during
recording, e.g. Netscape. The only solutions are: 1) record with IE, and 2) ignore the differences and errors
in the embedded Web Page viewer.

Q: Why do all these Security Alert messages appear when | am recording or inspecting a testcase?
A: Because Web Performance products use "fake" server certificates during the recording process in order
to decrypt secure pages from the server. See these instructions to silence the warnings.

Q: How do | record a site that uses Client Certificates?
A: See the Client Certificates section and the Authentication section.

Q: My browser is not recognized. Can | record testcases with it?
A: Yes, if the browser supports HTTP/S proxies. See the Manual Browser Configuration FAQ (next ques-
tion).

Q: How do | configure the browser manually for recording?
A: Follow these three steps:

1. Manually configure the ports that Analyzer will use for recording so that they will not change each time
Analyzer starts. See the General Settings page for more help.

2. Configure Analyzer to start a custom browser when recording is started (Browsers section of the Pref-
erences page). A custom browser may need to be configured if the browser was not automatically
detected. Then the browser configuration should be set as the default browser. See the Browser Set-
tings page for details.

3. Configure the browser to use Analyzer's recording ports as a proxy. This step is dependent on your
browser - see the browser documentation for more information.

Q: | have URLs in my testcase from a server that | do not wish to test.

A: If the URLs are not important to the testcase (such as images or links for link tracking, click analysis etc),
they can be deleted from the testcase using the Cutitem in the pop-up menu for the transaction. These
URLSs can be added to the URL blocking list - see the Blocking Undesired Transactions section of the man-
ual.

If all the URLSs for a particular server (host name) should be ignored, you can use the Host name blocking
list, also described in the Blocking Undesired Transactions section.

Testcase Analysis FAQs

How can | determine the total size of a web page, including images and scripts?

1. Record the pages
2. In the Editor, check the Size column.
3. Expand the page in the tree to see the sizes of individual resources on the page




How can | examine the HTTP headers my server is returning?

1. Record some pages from your server
2. Open the Headers view
3. Select the page or URL of interest in the Editor

How can | see the cookies my browser is sending to a web server?

The cookies are sent between browser and server in the Cookie and Set-Cookie headers. See the Headers
HowTo.

How can | determine if my web pages are getting faster or slower?

Follow these steps in the Quick Start Guide:
1. Create a recording
2. Replay a testcase
3. Analyze the Performance Changes

How can | find the slowest pages on my website?

1. Record the pages of your website
2. In the Editor, click the Duration column to sort the recording by page duration

How can | find errors on my website?

1. Record the pages of your website
2. Open the Error view

How fast will my web pages be over a modem?

There are two ways to answer this. If you have not already created a recording of the pages of interest:
1. Start a new Recording
2. On the Start Recording dialog, selected the desired modem/network speed.
3. Inspect the web page durations in the Editor
If you already have a recording of the pages, you can replay it with a specific network speed this way:
1. Record the pages of your website
2. Open the Replay View and set the Bandwidth Limit to the desired modem speed
3. Replay the testcase
4. Inspectthe web page durations in the Editor ...or...
5. Open a Performance Trend chart for the testcase to see the difference in speed of each page plotted
on a chart

How can | find parts of my website that do not match my performance goals?

1. Record the pages of your website
2. Configure one or more performance goals




3. Inspect the replay in the Editor - failed goals will be indicated by the @ icon.

How can | export report data to other formats?

Each data table has a link at the bottom titled export to csv. Clicking this link will invoke a dialog for saving
the data. When viewing the report in an external browser, clicking the link will show the data in the browser.
Most browsers have a function for saving a link content rather than navigating to it. In IE, the context menu
item "Save Link As..." will perform this function.

Testcase Configuration FAQs

How can | change the URL recorded for a Web Page or transaction?

1. Open the Headers View
2. Select the desired Web Page or transaction
3. Editthe URL

How can | change a header in a transaction?

1. Open the Headers View
2. Select the desired Web Page or transaction
3. Editthe Header

How can | change the testcase to send different values in place of form fields or query parameters?

Open the Fields View

Select the testcase in Navigator

Locate the field(s) in the Fields View

Single values (or duplicate identical values) can be edited in-place by double-clicking the table cell
Multiple unique values can be changed to all have the same value by opening the Edit Field dialog
(Edit button) and then entering a Constant Value.
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How can | change the testcase to send different values in a form field on each replay?

—

. Create or import the desired values in a dataset

2. Configure modifiers on each field/parameter in the Fields View by opening the Edit Field dialog (Edit
button)

3. Each time the testcase is replayed, the next value from the dataset will be used (depending on the

dataset configuration). To reset the dataset to the beginning, select the Reset dataset state item from

the Replay View menu.

How can | change the username and password used in the testcase?

See the Authentication Section.




How can | create custom transactions or testcases without recording them?
Each transaction may be imported one at a time from an existing file.
How can | repeat part of a testcase?

Open the testcase properties dialog (Properties... item from the pop-up menu on the testcase in the Navi-
gator). You can select the start-point and end-point for looping within the testcase. When the Virtual User
runs the testcase, it will start from the beginning and proceed to the configured end-point (Run-To Page).
Then it will restart at the start-point (Restart-At Page) and continue. When the load test is stopped, it will then
run to the end of the testcase.

What happened to the hostname redirect column in the load configuration editor?

In previous versions of Load Tester (4.1 and earlier), when creating a load configuration, it was possible to
redirect all requests in a particular test case to a specific host. As of version 4.2, this capability has been
replaced. You can instead edit the hostname in the Fields view in the same way that you would edit any
other field. In the Fields view, select the hostnames customization and select the occurrences to be changed
(CTL-A to select all) and choose Edit... from the pop-up menu. If the testcase has multiple hostnames and
you only wish to redirect one, the filter field at the bottom will make it easier to select only the transactions tar-
geting that host. In the Field Editor dialog, configure the hostname field to use a different source, such as a
text constant for a single host or a dataset to test multiple hosts simultaneously.

Replay FAQs

Q: How can | replay a testcase?
A: See Replaying section.

Q: How can | ensure my testcase was replayed correctly?
A: Manually, the pages can be inspected to see if the testcase replayed correctly. Select the replay in the
Testcase Editor and then select the page to be inspected. The page will appear in the Content View.

To automate this procedure, validators can be applied to each page to check the testcase in a automated
fashion

Open the Validators View

Select the page to check in the Testcase Editor

In the Validators View, apply settings for size and/or content validation.

Replay the testcase

Open the Errors View - an error should appear in the table for any failed validators
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Q: When | replay my recording, the value of some of the cookies are different. Why didn't Analyzer replay
exactly what | recorded?

A: Analyzer is much more than a simple HTTP recorder/replayer. It simulates a real browser interacting with
your server. This means that if the server sends new cookies, Analyzer will use them, just like a real browser



does. As a result, Analyzer is compatible with sophisticated websites that require a user login and track ses-
sion state using cookies.

Q: | want to change the username and password used in my testcase
A: See the Authentication section

Q: How do | replay with different users each time the testcase runs?
A: See the Authentication section

Q: How can | see which values are being used from a dataset during a replay?

A: The Replay View contains a tab that shows the current state of the datasets during a replay.

Open the Replay View

Select the Datasets tab

Replay the testcase.

If the testcase has very short think times between pages It may be helpful to step through the testcase

one page at a time using the page-step button (see the Toolbar for the replay button descriptions)

5. The Datasets tab will indicate which datasets are in use by the Virtual User and what the values are
for each field in that dataset row.
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Q: How can | replay every testcase in a repository
A: Select the Advanced Replay... option from the Replay toolbar button ( ¥ ) drop-down menu a